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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Introduction to Quality Management Cloud

Overview of Quality Management  
Oracle's Quality Management provides a unified platform for enabling quality visibility, collaboration, and execution.

The key focus of Quality Management is to:

1. Facilitate inspections at critical points throughout supply chain execution
2. Guide users through the quality issue resolution and corrective action process
3. Provide quality teams with enterprise level quality control and closed-loop quality management

The four key steps in Quality Management are: Define, Identify, Analyze, and Correct. The Define and Identify tasks
together constitute Quality Inspection Management, while the Analyze and Correct tasks together constitute Quality
Issues and Actions Management.

Quality Inspection Management
Quality Inspection Management enables you to:

1. Define quality requirements for both materials and resources, which has been implemented through the
definition of:

◦ Inspection Levels for Receiving

◦ Inspection Characteristics

◦ Work in Process Inspection Plans

◦ Receiving Inspection Plans

◦ Inventory Inspection Plans

◦ Resource Inspection Plans

2. Allow users to perform inspections at key points in the supply process

◦ In-line Work in Process Inspections

◦ In-line Receiving Inspections

◦ Ad-hoc Inventory Inspections

◦ Ad-hoc Resource Inspections

◦ Ad-hoc Work in Process Inspections

3. Allow users to analyze the results of inspections to identify failures or nonconformances. Infolets for Work in
process Inspection Failures and Receiving Inspection Failures are available out of the box, and OTBI is available
for ad-hoc reporting.

You can quickly access different quality inspection management pages from the Supply Chain Execution page itself
by clicking the links listed in Quick Actions. You can also use the Ask Oracle search to filter and directly navigate to the
quality inspection management pages.
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Quality Issue and Action Management
Quality Issue and Action Management is a part of Product Management Cloud that integrates with other Oracle Fusion
applications to help you achieve closed loop quality. Primarily, it helps you:

• Identify nonconforming products and resources during the supply, manufacturing, storage, development, and
shipping stages of a product lifecycle.

• Link quality issues to corrective actions to change orders.

• View issues and actions.

Use the Quality Management landing page to view key quality metrics displayed in infolets, related to quality issues,
quality actions, inspection plans, and inspection results, depending on your access privileges. Use this page to view
issues and actions that are assigned to you. Unassigned issues are summarized in an infolet. A user can assign it to
another user by changing the Assignee.

You can search for quality events or inspections data on the landing page, depending on your job role.

When you access Quality Management as a quality analyst, a quick search requires only the number of the quality issue
or quality action. Use Filtered search to look for quality issues or quality actions by any of their attributes, and save
personalized searches to run them again.

Search results are filtered by the organization to which you're assigned. Click one of the entries in the search results to
open the specific quality issue or quality action detail screen.

Roles and Privileges in Quality Management  
Roles and privileges define tasks that you can perform in a work area. By assigning roles to users, you can control the
tasks they can perform and work areas they can access.

You can either add users to roles or assign multiple roles to a user. You can assign privileges ONLY to roles and not to
the user directly.

With the role of a quality engineer, you can create, manage, and review inspection characteristics, levels, plans, and
quality inspections. Other roles like the production operator, warehouse operator, and receiving agent enable you to do
different types of inspections.

With the role of a quality analyst, you can create, manage, and review quality actions and issues and also navigate to the
items and change orders in Product Development (with the required privileges).

Note:  Assigning predefined roles and privileges as is to users may impact subscription usage, so it’s recommended
that you create your own roles with the privileges your users need to perform their tasks. See the related links for
more details.

The following table lists the privileges for Quality Management functions. Use this as a reference to identify which
privileges you must assign to your configured roles.
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Functions Privileges

• Create and review inspection
characteristics

• Create and manage inspection levels

• Create and manage inspection plans

• Create and manage inspections

• Create quality issues

• Review quality issues

• Manage quality issues

• Manage inspection characteristics

• Manage inspection levels

• Manage inspection plans

• Record and edit inspection results

• Create quality issues - (ENQ_CREATE_QUALITY_ISSUE_PRIV)

• Review quality issues - (ENQ_REVIEW_QUALITY_ISSUE_PRIV)

• Manage quality issues - (ENQ_MANAGE_QUALITY_ISSUE_PRIV)

• Do inline work in process inspections

• Do improvised resource inspections

• Record and edit inline work in process inspection results

• Record and edit unplanned resource inspection results

Do inline receiving inspections.
 

Record and edit inline receiving inspection results.
 

Do inline receiving inspections.
 

Record and edit inline receiving inspection results.
 

• Create and review quality issues and
actions

• Create and manage quality issues
and actions.

• View Item on Affected Object Search.

• Create quality issues and actions

• Review quality issues and actions

• Manage quality issues and actions.

• View Item Change Order.

• View Create Change Order Action
Menu

• View Item details Name, Description,
 and other details for Items added on
Affected Object.

• Manage Item Change Order

• Item Inquiry

• Manage item

• Review Receiving Receipt Summary.

Note:  Ensure that you add data security grants and the respective item and change order privileges, to the role, to
see the items and change order objects.

For example, to give View Only access to users, you can create a new SCM job role, and either add the 'Quality
Inspection Review' shipped duty role or separately add the 'View Inspection Results', the 'View Inspection Plans', the
'View Characteristics', and the 'View Inspection Levels' privileges to it. When you assign this new job role to users, they
can only view inspection levels, inspection characteristics, inspection plans, and inspections, but not edit them.

You can't edit actions or issues with ONLY the Review privilege. The issue and action screen displays in the read-only
mode. You can still:

• View general attributes

• Add a comment

• View and download attachments

• View details and click links of affected objects and related objects

• Launch Graphical Navigator

• View the workflow infotile

3
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• Mark as favorite

• Approve (if requested as Approver)

• Search

• See actions in the Infolets in the work area Overview page.

Related Topics
• Guidance for Assigning Predefined Roles

• Advisory Note on Subscription Impact

Secure Access to Product Management Objects  
To allow users to access items, change orders, problem reports, and corrective actions, you must ensure that they're
assigned the following privileges from the Security Console.

Access to Items and Change Orders

Add the following to ensure that a user can view items and change orders from the Quality Management work area.

Privileges Data Security Policy

View Item Change Order
 
Manage item
 

EGP_SYSTEM_ITEMS_B
 
EGO_ENGINEERING_CHANGES_B
 

Note:  Users with the item privilege EGP_VIEW_ITEM_PRIV can view the Quality tab on the item details page.

Secure Access to Problem Reports and Corrective
Actions  
To secure a problem report or corrective action from unauthorized access, you can click the Security tab in a problem
report or corrective action and add the users who should have access to it.

Note:
• Users in the supplier organization can only view and submit problem reports or corrective actions.

• You can also secure extensible flexfields appearing on problem reports and corrective actions. For more
information, see the topic Secure Extensible Flexfields for Change Types.

Here are some things you must know about a new problem report or corrective action:

• All users can access problem reports or corrective actions, until you restrict access.

4
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• If you add a new user or group to restrict access, the creator and assignee are added automatically.

• To remove the creator and assignee, use the Delete All option.

To enable users to view or approve a problem report or corrective action, an administrator must also provide the
necessary privileges.

When you search for a problem report or corrective action using any criteria, the search results show only the problem
report or corrective action that you're allowed to view.

Supplier and Supplier User setup is handled in the Oracle Fusion Cloud Procurement. For more information, see the
Oracle Fusion Cloud Procurement Implementing Procurement guide.

Access to Problem Reports and Corrective Actions
Users can view problem reports and corrective actions from the Quality Management  work area or in Supplier Portal
by adding the following from the Security Console.

Note:  Assigning predefined roles and privileges as is to users may impact subscription usage, so it’s recommended
that you create your own roles with the privileges your users actually need to perform their tasks. See the related links
for more details.

Privileges to view or manage the problem reports or corrective actions for quality management users:

Privileges Data Security Policy

View Item Change Order
 
Manage Problem Report
 
Manage Corrective Action
 
View Problem Report
 
View Corrective Action
 
Monitor Product Management Workflow
Objects
 

Access the item change for table EGO_ENGINEERING_CHANGES_B for the item changes they've access
to.
 

With the View Problem Reports and View Corrective Actions privileges, you can provide access to view problem
reports and corrective actions in all statuses including the draft status. To gain view or manage access to problem
reports and corrective actions, along with the View or Manage privilege you must have the Monitor Product
Management Workflow Objects privilege.

Privileges to view or manage the problem reports or corrective actions for supplier portal users:

Privileges Data Security Policy

View Item Change Order
 
Manage Supplier Problem Report
 
Manage Supplier Corrective Action
 
Access Supplier Portal Overview

To enable access to the item change for suppliers, you must also assign a custom data policy with the
following predefined condition - Access the item change for table EGO_ENGINEERING_CHANGES_B for
the item changes they created.
 

5



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 1
Introduction to Quality Management Cloud

Privileges Data Security Policy

 
View Problem Report in Supplier Portal
 
View Corrective Action in Supplier Portal
 
Monitor Product Management Workflow
Objects
 

Related Topics
• Troubleshoot Issues in Change Objects

• Guidance for Assigning Predefined Roles

• Advisory Note on Subscription Impact

6
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2  Quality Inspection Characteristics

Inspection Characteristics  
Use inspection characteristics to specify the range of acceptable values or specification limits for items and non-items.

You use inspection characteristics to:

• Create inspection plans

• Conduct ad-hoc inspections, where you can directly add the characteristics to result collections

• Collect data

During inspections, you evaluate units against inspection characteristics. The samples or serials that are within the
conformance limits are accepted and the rest are rejected.

Related Topics
• Types of Inspection Characteristics

• Associate an Inspection Characteristic with a Characteristic Group

• Considerations for Updating Inspection Characteristics

Types of Inspection Characteristics  
You can define item based and non-item based inspection characteristics.

Item Based Inspection Characteristics
You can link item-based inspection characteristics with attribute values in an item class. This enables you to verify if
an item meets the required product specifications. The item based inspection characteristics generally have a range of
acceptable values or specification limits, as well as target or optimal values.

Non-Item Based Inspection Characteristics
You can define inspection characteristics that aren't mapped to item attribute values. These non-item inspection
characteristics can be of type: Number, Character, or Date. You must specify a target value for all of the types, and where
applicable, a range or list of valid values as well as a unit of measure.

Note:  For a non-item inspection characteristic of type: Character, you can choose not to specify a value set. This
enables you to enter free-form text for that characteristic during an inspection. Any result entered for such a
characteristic added directly to an inspection or as part of an inspection plan is accepted without an evaluation
against specifications, and is recorded for data collection purposes.

You can use the non-item based inspection characteristics for both item and resource related inspections.

7



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 2
Quality Inspection Characteristics

Related Topics
• Inspection Characteristics

• Associate an Inspection Characteristic with a Characteristic Group

• Considerations for Updating Inspection Characteristics

Associate an Inspection Characteristic with a
Characteristic Group  
A characteristic group is a set of inspection characteristics. You may associate an inspection characteristic with one or
more characteristic groups.

Characteristic groups are very useful to add a set of characteristics to an inspection plan or inspection result, at a time,
without having to add them separately.

Related Topics
• Inspection Characteristics

• Types of Inspection Characteristics

• Considerations for Updating Inspection Characteristics

Considerations for Updating Inspection Characteristics  
Consider these points while updating item based and non-tem based inspection characteristics.

Updating an Item Based Inspection Characteristic
Here are some points to consider while updating an item based inspection characteristic:

• If the item inspection characteristic is not included in an inspection plan or if the inspection result value is not
recorded against the characteristic, you can update all attributes of the inspection characteristic.

• If the characteristic type is either Date or Numeric and the item inspection characteristic is included in an
inspection plan, or if the inspection result value has been recorded against the characteristic, then you can only
update the Description, Enabled/Disabled, and Characteristic Group Association fields.

• If the characteristic type is Character and the item inspection characteristic is included in an inspection plan, or
if the inspection result value has been recorded against the characteristic, then you can modify the Description,
Enabled/Disabled, characteristic group association to the characteristic and Value List.

8
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Updating a Non-Item Based Inspection Characteristic
Here are some points to consider while updating a non-item based inspection characteristic:

• If the non-item inspection characteristic is not included in an inspection plan or if the inspection result
value has not been recorded against the characteristic, then you can update all attributes of the inspection
characteristic.

• If the characteristic type is either Date or Numeric and the non-item inspection characteristic is included in an
inspection plan, or if the inspection result value has been recorded against the characteristic, then you can only
update the Description, Enabled/Disabled, and Characteristic Group Association fields.

• If the characteristic type is Character and the non-item inspection characteristic is included in an inspection
plan, or if the inspection result value has been recorded against the characteristic, then you can modify the
Description, Enabled/Disabled, Characteristic Group Association, and the Value List fields.

Related Topics
• Inspection Characteristics

• Types of Inspection Characteristics

• Associate an Inspection Characteristic with a Characteristic Group

What happens if I disable an inspection characteristic?  
When an inspection characteristic is disabled, it won't be available while creating a new inspection plan and a new
inspection.

However, if an inspection characteristic is already used either in an existing inspection plan or an existing inspection,
irrespective of it being enabled or disabled, it displays the value recorded during the inspection.

9
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3  Quality Inspection Levels

Inspection Levels  
An inspection level determines the relative amount and frequency of inspection.

You create an inspection level and associate it with a Receiving or Work in Process inspection plan.

With inspection levels, you can determine if:

• The entire quantity must be inspected, or if sampling should be employed

• All receipt lines must be inspected or if some can be skipped

Note: Skip lot is applicable only for the Receiving inspections.

Except for the Receiving plan type and the Work in Process plan type, all other plan types only allow 100 percent
inspection level.

When sampling is enabled in an inspection level, you can choose one of these sampling types:

Sampling Plan Type Description

ANSI/ASQC Z1.4 Standard
 

Where certain number of defects are acceptable, you can define inspection levels with acceptance
sampling based on different acceptable quality limits. For example, based on the size of the quantity
received, you can automatically derive the tolerance limit for acceptable defects. During inspection, if
defects are within the tolerance limit, you can accept the received quantity.
 

Fixed Count
 

Specify the fixed number of samples to be inspected. This enables you to inspect a fixed number of
samples irrespective of the
 

• receipt line quantity during a receiving inspection, and

• work order operation completion quantity during a work in process inspection.

Percentage
 

Specify the percentage of the total quantity to be inspected.
 

Also, you can specify the amount of material required to perform all tests against a single sample, including a sample
quantity unit of measure.

During inspection, once results are entered for the required samples, the inspection disposition is automatically
determined as accepted or rejected based on the inspection level leveraged in the inspection plan:

• With percentage-based sampling and fixed count sampling, the entire inspection quantity will be rejected if
even one of the representative samples fails the inspection.

• With AQL sampling, the entire inspection quantity will be rejected if the number of representative samples
that fail inspection is greater than or equal to the rejection quantity as set forth in the Acceptable Quality Limit
tables

11
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Note:  If either percentage or fixed count inspection level is selected in an inspection plan, during the in-line work in
process inspections for serial controlled items, you can use the Inspect All option, only for completion quantities of
less than 800.

Related Topics
• Examples of Inspection Levels

• Inspection Plans

Examples of Inspection Levels  
You can define levels based on factors such as frequency of checks, complexity, item value, credibility of the supplier,
acceptance history, and so on.

Scenario
For example, you can have three different levels: reduced, normal, and tightened inspection levels:

• Reduced inspection level: where fewer samples are required and less often, due to high level of confidence.

• Normal inspection level: will be the default inspection level, which will be widely used.

• Tightened inspection level: where more samples are required and more often, due to problematic suppliers or
high value items.

Inspection Levels ensures adherence to the quality standards and helps you make informed acceptance decisions.

Skip Lot Enabled: You can control the frequency of inspection based on the lots to be inspected out of the total lots
received. For example, you can choose to inspect one out of every five receipt lines.

Sampling Enabled: You can choose the sampling plan type as one of these

• Percentage

• Fixed Count

• ANSI/ASQC Z1.4 Standard

Quantity Per Sample: You can specify the amount of material required to perform all tests against a single sample,
including a sample quantity unit of measure.

Example for Percentage sampling plan type

Let's consider a scenario where inspection level is defined for 2% sampling. If 1000 units are received, then 20 samples
are inspected.

Example for Fixed Count sampling plan type

12
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Let's consider a scenario where inspection level is defined as fixed count 10. If 1000 units are received, then only 10
samples are inspected.

Example for ANSI/ASQC Z1.4 Standard sampling plan type

When defining an inspection level, you can select the following information as part of an acceptable quality limit
sampling plan:

• Select a predefined ANSI standard as the sampling plan type

• Choose the sampling code and level

• Specify the acceptable quality limit which is the percentage of the sample that can be rejected while still
accepting the sample

For example, if you receive 20 each for quality inspection, have a single sampling plan for normal inspection with
general inspection level II, and have an acceptable quality limit of 2.5, the sample size is 5 each. The number of rejected
units must be equal to or less than the acceptance number of zero to accept the receipt line quantity. If the rejected
units are equal to or greater than the rejection number of one, the receipt line quantity is rejected.

Example for the Quantity per Sample and Sample Quantity UOM

Let's consider a scenario where you must collect half liter per sample against a mixing task in a process manufacturing
work order, where the production is measured in gallons. To enable this sampling setup, define an inspection level with
the Quantity per Sample value set to 0.5 and the Sample Quantity UOM set to Liter. If you have used this inspection
level in an inspection plan, and that plan is used for ad hoc WIP inspection, both quantity per sample and total quantity
values are displayed while creating the inspection. The total sample quantity is displayed both in the transaction UOM
and sample quantity UOM. You can also view these details on the Inspection Details page.

Note:  While creating an inspection, if either the transaction quantity can't be converted to the sample quantity's UOM
or the total sample quantity exceeds the transaction quantity, you get an error message.

Related Topics
• Inspection Levels

• Inspection Plans

13
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4  Quality Inspection Plans

Inspection Plans  
An inspection plan contains inspection elements that represent the specific data that you want to collect and report on.
It also contains information about when and how often you collect that data.

The following table lists the five types of inspection plans and their use:

Plan Type Used to Collect Data and Report On

Receiving
 

Items received at the warehouse
 

Resource
 

Equipment or machinery in Shop Floor
 

Inventory
 

Items in your inventory
 

Work in Process
 

Work order execution
 

Asset Assets, asset groups; items, and item categories

While creating an inspection plan, you must specify the plan details, specifications, and criteria.

You can specify target values and limits for inspection plan characteristics. If the actual results entered aren't within the
limits, a quality issue is created based on the action rule that you’ve defined.

Related Topics
• Overview of Inspection Plan Details

• Plan Statuses

• Considerations for Making a Plan Optional

• How can I copy a plan?

Inspection Plan Details  

Overview of Inspection Plan Details  
Specify the plan details like the plan type, status, organization, item or item catalog, and so on.

15
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These plan details are useful to automatically match and associate a plan with an inspection.

Note:  If you are creating the inspection plan for an item catalog, then select the catalog associated with one of
these functional areas: Inventory, Purchasing, Planning, or Quality Inspection Management.For receiving and work
in process in-line inspections, when there are applicable plans defined against more than one functional area, the
priority sequence of selection will be:

• Receiving: Quality Inspection Management, Purchasing, Inventory, and then Planning.

• Work In Process: Quality Inspection Management, Planning, Inventory, and then Purchasing.

On the Redwood UI, while defining the plan usage parameters, you can invoke generative AI by clicking the AI Assist
button to automatically create the description for the inspection plan version based on the preliminary information. You
can then either edit the description or click the AI Assist button again to regenerate the description.

Note:  The AI Assist button to automatically generate the description suggestions for the inspection plan version
isn’t enabled by default. Your administrator needs to make this button visible using Visual Builder Studio. For more
information on using Visual Builder Studio, see the Overview of Using Visual Builder Studio topic on Oracle Help
Center.

Related Topics
• Inspection Plan Specifications

• Inspection Plan Criteria

• Overview of Ad Hoc and Inline Inspections

Plan Statuses  
This table lists the various statuses available for the plan:

Plan Status Description

New
 

A plan that's not yet approved.
 

On hold
 

Put an approved plan on hold when you want to make it temporarily unusable.
 

Obsolete
 

You can't use an obsolete plan. However, you can make changes to it and approve the plan to use it
again.
 

Approved
 

You can only use approved plans for inspections.
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Related Topics
• Inspection Plan Specifications

• Inspection Plan Criteria

• Overview of Ad Hoc and Inline Inspections

Inspection Level in Inspection Plans  
By default, all plans have 100 percent inspection level. This means that all units must be inspected, all the time. The only
exception is for the Receiving and Work in Process plans, as they allow user-defined inspection levels.

With user-defined inspection levels, you can do selective inspections:

• Sampling: Inspect only selected samples based on the specified sampling type.

• Skip Lots: Skip inspection for some of the receipt lines.

Related Topics
• Plan Statuses

• Inspection Plans

Considerations for Making a Plan Optional  
You can mark a plan as optional when you want to do ad hoc inspection. However, if you want to do inline inspections,
you must not make a plan optional.

Related Topics
• Inspection Plans

• How can I copy a plan?

• Can I use multiple versions of the same inspection plan at the same time?

• Overview of Ad Hoc and Inline Inspections

How can I copy a plan?  
Once you save a plan, you can copy and create a new plan.

This is particularly helpful when you want to: .

• Create a new plan with slight changes to an existing plan.

• Selectively copy the plan elements like the inspection criteria, action rules, and attachments.

• Copy the inspection plan within the same organization or to a different organization.
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• Search to filter and select an item or an item catalog, and thereby, copy the plan to the selected item or item
catalog.

Note:  You can only copy a plan between the same inspection type. For example, you can copy a plan from an
inventory plan to another inventory plan, but not to a work in process plan.

To copy a plan, on the Create Inspection Plan page, from the Actions drop-down list, select Copy Plan.

Related Topics
• Inspection Plans

Inspection Plan Criteria  
Specify inspection criterion for Receiving, Inventory, and Work in Process inspection plans.

Based on the plan type, the inspection criteria can be as listed in the following table:

Inspection Plan Type Inspection Criteria

Receiving inspection plans
 

• Suppliers and supplier locations for the document type: Purchase order

Note:
When you select a supplier and don't specify a location, then that inspection plan becomes
applicable to all the locations for that supplier.
 
You can define an inspection plan that will be applicable for all suppliers without specifically adding
inspection criteria for each supplier separately. This means that while creating an inspection plan,
 under Inspection Criteria, select the document type as Purchase order without specifying any other
value for the Supplier field.
 

• Source organization for document types: In-transit shipment, Return material authorization, and
Transfer order

Inventory inspection plans
 

Subinventory and locators
 

Work in Process inspection plans
 

Operation Code or Operation Sequence or both along with the Dispatch Status

Asset
 

Work Order Type, Work Order Subtype, Work Definition, Operation Sequence and Operation Code.
 
Note: If you select the values for work order type or subtype, work definition attributes, operation
sequence, or operation code attributes, then the inspection becomes applicable for maintenance work
orders.
 
Inspection plan criteria is optional for an Asset inspection plan.
 

Note:   You don't separately specify inspection criteria for Resource Inspection plans, as no additional criteria is
required other than the information entered in the plan details.
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Related Topics
• Inspection Plan Specifications

• Inspection Plans

• Overview of Ad Hoc and Inline Inspections

Can I use multiple versions of the same inspection plan
at the same time?  
No. At any point of time, you can only use one version of a plan to do inspections.

When you create a new version, you specify a start date. If you have not specified an end date for the previous plan
version, the previous version becomes obsolete a day before the new version's start date. From the new version's start
date, you can start using it for new inspections.

Related Topics
• Inspection Plan Specifications

• Inspection Plan Criteria

• Inspection Plans

• Overview of Inspection Plan Details

Inspection Plan Specifications  
Add inspection characteristics or characteristic groups or both to specify the attributes of inspection. This also enables
you to specify the measurements to be collected during an inspection.

On Redwood UI, you can invoke the generative AI by clicking the AI Assist button to automatically generate a list
of suggested inspection plan specifications. You can then review, edit, and accept the proposed inspection plan
specicifications.

Note:  The AI Assist button isn’t enabled by default. Your administrator needs to make this button visible using Visual
Builder Studio. For more information on using Visual Builder Studio, see the Overview of Using Visual Builder Studio
topic on Oracle Help Center.

For the Resource inspection plan, you can only add non-item inspection characteristics.

For other plans you can add both item and non-item inspection characteristics.

You can mark an inspection characteristic as optional. During inspection, for an optional characteristic, you may or may
not enter a result value.

19



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 4
Quality Inspection Plans

Also, you can set an inspection characteristic to automatically default the result value from the target value associated
with the specification line during an inspection. If required, during inspection, you can change the default value of an
inspection characteristic.

Related Topics
• Inspection Plan Criteria

• Overview of Inspection Plan Details

• Inspection Plans

Manage Action Rules  
Use inspection action rules to either guide the users or automatically trigger an action based on the inspection results.
While creating or modifying an inspection plan, use the inspection characteristics listed in the Specifications tab to
create action rules.

An action rule can have one or more conditions. Configure the rule to trigger any of the following actions when the
conditions are met:

• Change Material Status: On saving the result, the status of the material changes at the subinventory, locator, lot,
or serial level.

• Create a Quality Issue: On saving the result, the application automatically creates a quality issue.

• Display Message: On entering or evaluating the result value, a message appears on the Inspection Results page.

• Raise an Event: On saving the inspection, a business event triggers which you can leverage to call a service or
API.

• Send a Notification: On saving the inspection, the specified recipient receives an email notification.

• Create a Maintenance Work Order: This action is displayed only for an Asset inspection plan type. On saving the
inspection, the application automatically creates a maintenance work order.

To create a rule, save the inspection plan and do the following:

1. In the Quality Management work area, open the inspection plan, and select Inspection Characteristics.
2. Under inspection characteristics, click Manage Action Rules.
3. Click Create Action Rule.
4. Click the Attributes tab and select the characteristic for the IF condition.
5. Click the Actions tab and select one or more actions to trigger for the Then or Else part of the condition.
6. Save and close the action rule.
7. Close the Manage Action Rules.
8. Save the inspection plan.

You can also duplicate or delete a rule. For example, to delete a rule, from the Manage Action Rules page, select the rule
and from the Actions drop-down list, select Delete.
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5  Quality Inspections

Overview of Ad Hoc and Inline Inspections  
Based on the inspection plan type, you can perform an ad hoc inspection or inline inspection or both.

The following table lists the plan types and the inspections they support:

Plan Type Supported Inspections

Inventory
 

Ad hoc inspections
 

Resource
 

Ad hoc inspections
 

Receiving
 

Inline inspections
 

Work in Process
 

Both ad hoc inspections and inline inspections
 

Asset
 

Ad hoc inspections

Note:  When you have many result values to enter, you can use the REST API services. This helps you get better
performance and do faster inspections. For more information about using REST APIs, see the inspection related tasks
under the Manufacturing section in the REST API for Oracle Fusion Cloud SCM guide.  You can use the Visual Builder
Cloud Service add-in for Excel with the REST API services. For more information, see the Oracle Visual Builder Add-In
for Excel topic in the Oracle Fusion Cloud Applications Using Common Features guide.

Related Topics
• Ad Hoc Inspections

• Inline Inspections

• Skip Lot and Sampling Inspections: Overview

Ad hoc Inspection Flow  
The ad hoc inspection flow of the Asset, Inventory, Work in Process, and Resource is just creating an inspection plan and
inspecting them. The reason is they aren't tied to any transaction.

You can do an ad hoc inspection at any time, even on historical data.

Here is the ad hoc inspection flow of the Asset, Inventory, Work in Process, and Resource:
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In-line Inspection Flow of Receiving Inspection  
Here is the in-line inspection process flow of receiving:
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In-line Inspection Flow of Work in Process  
Here is the in-line inspection process flow of work in process:
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Ad Hoc Inspections  

Ad Hoc Inspections  
Ad hoc inspections are also called as standalone inspections. You can do these inspections any time.

With standalone inspections, you can collect inspection results without a parent transaction. For example, you can
collect inspection results against a work order operation, resource, or an assembly in inventory.

Create ad hoc inspections for Asset, Inventory, Resource, and Work in Process inspection plans from the Maintenance
landing page, Quality Management landing page, or Work Execution landing page.

While creating an inspection:

• If there are one or more matching inspection plans, select a plan that you will use to collect the inspection
results.

• If there is no matching plan, you must add the inspection characteristics for which the inspection results will be
collected.
Even if a plan is available, you may choose not to use it, and instead add inspection characteristics for
inspection. Also, even when you select a plan, you can add inspection characteristics as well. However, an
issue gets created only for a measurement that is out of the specifications based on the values defined in the
inspection plan.
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Disposition Status on Ad Hoc Inspections
Inspection results collected in standalone inspections display the disposition information. However, no action is initiated
as there is no parent transaction to implement the disposition. For example, no units are scrapped out of manufacturing
and no units are rejected in inventory.

Related Topics
• Performing Ad Hoc Inspections: Example

• What happens if I remove lines from an inspection?

• How can I inspect a line that is already rejected in an inspection?

• Capturing E-Signatures and Generating E-Records for Inspection Dispositions: Explained

• Inline Inspection: Worked Example

Performing Ad Hoc Inspections: Example  
This example demonstrates how to:

• Create an inventory inspection

• Collect inspection data

Scenario
Consider a scenario where there is an inspection plan to associate with the inventory inspection. This means, during
inspection, you will evaluate the inspection results against the inspection characteristics in a plan.

Prerequisites

• Create the required inspection characteristics and characteristic groups (optional)

• An inspection plan that:

◦ Is in "Approved" status

◦ Is valid for the inspection date, that is the inspection date is between the start and end date of the plan

◦ Matches the inspection details

◦ Includes inspection characteristics or characteristic groups or both needed for the inspection

Creating an Inventory Inspection

1. Open the Inspections page from either the Quality Management landing page or Work Execution landing page.
2. Enter the inspection details: organization, type, item, subinventory, locator, and the quantity to inspect.
3. Based on the inventory details, if there are one or more plans with same values, they automatically appear in

the Inspection Plan drop-down list. Select the applicable plan and click OK. The Enter Inspection Details page
opens.

Note:  It is not mandatory to select a plan. You can proceed even without selecting a plan.

25



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 5
Quality Inspections

Collecting Inspection Results
On the Enter Inspection Details page, for each unit, enter the inspection result for each characteristic, and click Save. As
soon as you enter results for all the units, the disposition status changes from Pending to Complete. If the inspection
results are within the specification limits, the samples or serials are automatically accepted. Similarly, the samples or
serials outside the specification limits are automatically rejected.

Note:  If you have enabled Electronic Signatures and Electronic Records, you can submit the inspection disposition
for approval. An E-Signature page opens where you can view the status of the approval process of the Inspection
Disposition.

Related Topics
• Capturing E-Signatures and Generating E-Records for Inspection Dispositions: Explained

• Electronic Signatures and Electronic Records for Quality Dispositions: Overview

How can I inspect Lot control items?  
You can do ad hoc inspection of a lot control item during work in process and inventory inspection. While creating the
inspection, enter the lot number of the item.

Note:  For a work in process inspection, if there are multiple operations, even if an item is a lot control item, you can
enter the lot number only in the last operation.  Entering the lot number is optional for a work in process inspection
and mandatory for an inventory inspection.

For Work in Process inspections with pre-assigned lot numbers, you can do ad hoc WIP inspection of the:

• pre-assigned lots against the last operation in a Discrete Work Order

• pre-assigned lot for any lot-controlled product or by-product against any operation in a Process Work Order

For Work in Process inspections without any pre-assigned lot numbers, you can do ad hoc WIP inspection of the:

• last operation in a Discrete Work Order

• any lot-controlled product or by-product against any operation in a Process Work Order

Inline Inspections  

Inline Inspections  
You can do inline inspections for the receiving and work in process transactions.
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While creating an inline inspection, if a matching inspection plan is found, and the plan has an inspection level
definition with Sample Quantity and UOM, based on those values the Quantity per Sample and Total Sample Quantity
are automatically calculated.

During inspection, based on the inspection results, units are automatically marked as either accepted or rejected.

For Receiving, you may inspect all units or choose to inspect only selected units using sampling and skip lot
inspections. However, skip lot is applicable only for the Receiving inspections.

Note:  With necessary access permissions, you can approve the inline electronic Signatures and electronic Records.
For more information, see the E-Signatures and E-Records Process Flow topic in the Using E-Signatures and E-
Records user guide.

Inspection Plans and Inline Inspections
You must have a matching inspection plan to do inline inspections. If a matching inspection plan is missing for an item,
inspection of that item halts until you create and associate an approved matching inspection plan.

Related Topics
• Skip Lot and Sampling Inspections: Overview

• What happens if I remove lines from an inspection?

• How can I inspect a line that is already rejected in an inspection?

• Inline Inspection: Worked Example

Skip Lot and Sampling Inspections: Overview  
You specify skip lot and sampling settings in an inspection level, and include that inspection level in an inspection plan.

When an inspection plan is leveraged to perform an in-line inspection, all the inspection level settings apply to that
inspection. That is, in the inspection level if you have enabled:

• Skip lot, you can do skip lot inspections. That is, the skip lot plan or schedule defines the frequency or ratio of
inspected lots and skipped lots.

• Sampling, you can do sampling inspections. That is, you inspect only a percentage of the total units, which will
determine if the entire lot is accepted or rejected.

• Both skip lot and sampling, you can do both skip lot and sampling inspections.

Related Topics
• Inline Inspections

• Skip Lot Inspections: Explained

• Sampling Inspections: Explained

• Inline Inspection: Worked Example
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Skip Lot Inspections: Explained  
In skip lot inspections, the skip lot schedule defines the frequency or ratio of inspected and skipped lots.

For example, if the inspection level is set to inspect one out of four lots, one out of four receipt lines for that item,
supplier, and inspection level combination will be picked, and listed for inspection.

Note:  Even if a line is marked for skip lot inspection, you can override the skip quantity inspection setting during
inspection and choose to inspect all samples.

Related Topics
• Sampling Inspections: Explained

• How can I inspect serial controlled items?

• What happens if I remove lines from an inspection?

• Inline Inspection: Worked Example

Sampling Inspections: Explained  
In sampling inspections, a percentage of the total received units are available for inspection.

With sampling inspections:

• Even if one sample in the lot fails the inspection, the entire lot is rejected.

• Similarly, if the samples selected for inspection passes the inspection, the entire lot is accepted.

On the contrary, when sampling is not enabled, each individual unit is accepted and rejected separately.

Note:  For receiving inspections, when sampling is enabled, during the inline inspection, if one or more samples fail
the inspection, and the entire lot is rejected, you can choose to inspect all units. Then the inspection ceases to be a
sampling inspection. You can then inspect all units, reject or accept each unit separately. This saves the entire lot from
getting rejected.

Related Topics
• Skip Lot Inspections: Explained

• How can I inspect serial controlled items?

• What happens if I remove lines from an inspection?

• Inline Inspection: Worked Example
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Inline Inspection: Worked Example  
This example demonstrates how to do inline sampling inspection for a receiving transaction.

Consider a scenario where you have ordered 30 units of an item from a supplier. You as the "Receiving Agent" want to
check only 10 percent of the total units received, and decide if you can accept or reject all the units.

Prerequisites

• Create the required inspection characteristics and characteristic groups (optional).

• Create an inspection level with sampling set to 10 percent.

• An inspection plan that:

◦ Is in "Approved" status

◦ Is valid for the inspection date, that is the inspection date is between the start and end dates of the plan

◦ Matches the receiving inspection details %

◦ Includes inspection characteristics or characteristic groups or both needed for the inspection

◦ Includes the inspection level with sampling set to 10

• Create a receiving inspection with the inspection plan having 10 % sampling inspection level.

Collecting Inspection Results
1. Login as the Receiving Agent.
2. On the Inventory Management page, in the panel drawer, click Inspect Receipts.
3. On the Inspect Receipts page, you may search with the receipt number. All the items matching the search

criteria appears in the list.
4. Click Inspect. The Inspect Lines page opens.
5. Select the item and click Enter Quality Results. The Inspect page for the selected receipt number appears.
6. As 10 percent is the sampling inspection level, you will see three samples randomly selected from the total 30

received units.
7. Enter inspection results and click Save and Close. The Inspect Lines page opens again with inspection status

of line as either accept or reject. That is, if all the samples pass the inspection, then all the 30 received units are
accepted. However, even if one sample fails the inspection, all the 30 units are automatically rejected.

8. Finish inspection of other items and click Submit.

Note:  If you have enabled Electronic Signatures and Electronic Records, only for an inline receiving
inspection, you can submit the inspection disposition for approval. An E-Signature page opens where you can
view the status of the approval process of the Inspection Disposition.
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Related Topics
• Inline Inspections

• Sampling Inspections: Explained

• How can I inspect serial controlled items?

• How can I inspect a line that is already rejected in an inspection?

• Capturing E-Signatures and Generating E-Records for Inspection Dispositions: Explained

What happens if I remove lines from an inspection?  
During inline inspections, there can be instances where you want to inspect one or more lines later, separately.

For example, there can be a line without a matching inspection plan. As you can't inspect a line without an associated
inspection plan, you can't proceed further. In this scenario, you can select that line and remove it from the inspection
list. This enables you to proceed with inline inspection of other lines.

The status of the removed lines appears as pending.

Related Topics
• How can I inspect a line that is already rejected in an inspection?

• How can I inspect serial controlled items?

How can I inspect a line that is already rejected in an
inspection?  
For work in process transactions there can be units, which initially fail the inspection, but can be reworked upon.

Once they are reworked and ready for re-inspection, you can inspect them using the same or a different inspect plan.
Based on the inspection results, you can either accept or reject them.

Related Topics
• How can I inspect serial controlled items?

• Overview of Ad Hoc and Inline Inspections

How can I inspect serial controlled items?  
You can inspect serial controlled items during work in process and inventory inspection. The inspection procedure for
serials is same as it's for samples.
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Note:  For serial controlled items, while creating an ad hoc inspection for an inventory or work in process, the
following values set for serial generation are considered:

• Entry at sales order, transfer order, or work order issue

• Entry at inventory pick

You can specify, if during inspection, results must be entered against samples or serial numbers.

Related Topics
• Sampling Inspections: Explained

• Overview of Ad Hoc and Inline Inspections

How is the inspection number for an inspection
generated?  
When you create an inspection, the inspection number is automatically generated as a concatenation of the inspection
results.

Inspection number for the:

• Inventory inspection is the concatenation of item number and subinventory.

• Receiving inspection is the concatenation of receipt number and item number.

• Work in process inspection is the concatenation of work order number and item number.

• Resource inspection is the resource name.

Can I implement Oracle Quality Management Cloud as a
standalone solution??  
No, Quality Management Cloud isn't intended to be a standalone solution without the Oracle SCM Cloud. It
complements the supply chain design and execution processes.

When do receipts go through Quality Management for
quality inspections?  
While configuring the Receiving application, in the Manage Receiving Parameters task, select the Use quality inspection
plan option. See the Receiving chapter in the Implementing Manufacturing and Supply Chain Materials Management
guide for more information.
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If there is an inspection plan that's applicable to the item on the receipt line and the supplier, the receipt goes through
the Quality Management user interface for inspection.

Note:  If you don't select the Use quality inspection plan option, you can do a simple receiving inspection and mark
if the inspection result is pass or fail, without routing it through the Quality Management user interface. Also, in
the Manage Receiving Parameters task, if you select the Allow routing override option, you can override the receipt
routing at receipt time. You can override this option at receipt time by changing the destination type for specific
suppliers, items, and orders.

Electronic Signatures and Electronic Records for Quality
Dispositions  

Electronic Signatures and Electronic Records for Quality
Dispositions: Overview  
Capture electronic signatures and create electronic records for quality inspection dispositions when you do the
following inspections:

• Ad hoc Inventory Inspection

• Ad hoc Resource Inspection

• Ad hoc Work in Process Inspection

• Inline Receiving Inspection

Note:  You can capture electronic signatures and generate electronic records for Inline Work in Process Inspections
during the Work Order Operation Transaction reporting in Manufacturing. For more information, see the Oracle SCM
Cloud Using Manufacturing guide.

When you operate a business across different countries, you may choose to enable this feature for all your inventory
organizations, or only certain inventory organizations where it is mandatory to maintain electronic records and
electronic signatures.

To capture electronic signatures and create electronic records, do the following prerequisite steps:

1. Enable Inline Electronic Signature for each inventory organization.

Navigation: Setup and Maintenance work area > Manufacturing Supply Chain and Materials Management
Offering > Facilities functional area > Configure Electronic Signature Preferences. For more information on
configuring e-signature preferences, see the Oracle SCM Cloud Implementing Manufacturing and Supply Chain
Materials Management guide.

2. Configure the business process rules to determine the approvers for each transaction.

Navigation: Setup and Maintenance work area > Manufacturing Supply Chain and Materials Management
Offering > Manage Task Configurations for Supply Chain Management. On the BPM Work list page, configure
the task: QAResultsERESHumanTask. For more information on Approval Groups, see the Oracle SCM Cloud
Implementing Manufacturing and Supply Chain Materials Management guide.
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Related Topics
• Capturing E-Signatures and Generating E-Records for Inspection Dispositions: Explained

• Overview of Ad Hoc and Inline Inspections

Capturing E-Signatures and Generating E-Records for Inspection
Dispositions: Explained  
Once you enable inline electronic signature for the Quality Inspection Disposition, you can enter all inspection results
and sign off the quality inspection disposition by submitting it for approval.

An electronic record is generated and the E-Signature page opens where you can view the status of the approval
process of the inspection disposition.

When you initiate the approval process, notifications are sent to all approvers. Approvers can view these in bell
notifications and click the notification to view the e-record approval page, read the e-record, enter their comments, and
approve or reject it.

Note:  If the initiator is also an approver, the initiator's signature is captured in the inline signature page. Notifications
are sent to subsequent approvers to capture the remaining signatures. The new or updated transaction data remains
in the pending status until all approvals are complete. You can refresh the E-Signature page to retrieve and view the
latest status of the e-record.

You can search and view the existing e-records from the Electronic Records work area. For more information on the
Electronic Records work area, see the Oracle SCM Cloud Using E-Signatures and E-Records guide.

Related Topics
• Electronic Signatures and Electronic Records for Quality Dispositions: Overview

• Overview of Ad Hoc and Inline Inspections

33



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 5
Quality Inspections

34



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 6
Quality Issues and Quality Actions

6  Quality Issues and Quality Actions

Overview of Quality Issues and Actions  
Here's an overview of the business objects in quality management - quality issues and quality actions.

A quality issue is a defect, deficiency, or a significant variation in a product's expected appearance or performance.
Quality Management can handle any type of issue, such as:

• Nonconformance (Outside Processing, Development Item, Audit Finding, Inventory, Receiving, Resource, Work
in Process)

• Design Failure (Item)

• Problem Report (Item, Supplier)

A quality action is a necessary activity required to mitigate a quality issue and prevent its further occurrences. Quality
Management provides a predefined list of quality action types, which the administrator can configure. These types
include:

• CAPA - Corrective Action

• CAPA - Preventive Action

• CAPA - Supplier Corrective Action

• CAPA - Development Action

• Failure Analysis - Design

• Failure Analysis - Manufacturing

• Audit - Audit Finding

Here's what you can do in the Quality Management Overview page:

Create a quality issue: Use the Create > Quality Issue menu to quickly create a quality issue with only essential
information such as Organization, Severity, and Source. You can then use the quality issue edit page to add more
information such as workflow, proposed dispositions, and descriptions. You can also mark issues as favorites to find
them easily later. Depending on the type of issue, you can manually provide the quality issue number.

Create a quality action: Use the Create > Quality Action menu to quickly create a quality action with only essential
information such as priority and workflow. Then use the quality action edit page to add more information such as
affected objects, status, and resolution date. You can mark quality actions as favorites to find them easily later.

View Summarized Data in Infolets: Use the infolets for a quick look at the status of your quality issues and actions.
You can then click the counts to drill down and view details of these objects.

Tasks, Clipboard, and Analytics:

• Tasks: Access Product Genealogy and Audit Reports using the Tasks side panel tab.

• Clipboard: Use the Clipboard to speed up your work in the Quality Management work area. You can drag (select
and move) or copy and paste multiple items from the clipboard into the Affected Objects and the Relationships
tabs of quality issues and actions. You can also do this from the Favorites and Recent Items tabs available in
the clipboard. Use the clipboard icon on the Affected Objects tab and the Relationships tab to copy items to the
clipboard. The clipboard retains its content when you sign out of the application and sign back in. Working with
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the clipboard, you can use previously viewed items or favorites, eliminate unnecessary searches, and improve
productivity.

• Reports and Analytics: Use Reports and Analytics to create reports and analytics about business objects.
Quickly view or run analytics and reports that are related to your work in the Reports and Analytics pane. You
can also create and edit analytics and reports with the required privileges.

You can also create problem reports and corrective actions from the Quality Management Overview page, if you've the
appropriate privileges.

Note:  You can configure and extend the pages and objects you see in the Quality Management work area using
Application Composer. An administrator can modify standard attributes, create additional attributes and modify the
search, create, and details pages. For details, see the Oracle Fusion Cloud SCM Configuring and Extending Product
Lifecycle Management guide.

Related Topics
• About Working with Quality Issues and Actions

• How to Use Clipboard

Search Options  
You can search for quality actions, quality issues, problem reports, and corrective actions in the Quality Management
work area, depending on the privileges you hold.

On the Search page, click Show Filters. The Filters panel appears, from which you can search applying any of the
following attributes: Saved Search, Number, Organization, Type, Assigned To, Severity, Name, Status Type. Click Save to
save your selections.

If you opt in to the feature Use Extensible Flexfields on Changes, Problem Reports and Corrective Actions, note that
you can search for problem reports and corrective actions using the Manage Problem Reports and Manage Corrective
Actions pages.

Related Topics
• Manage Problem Reports and Corrective Actions

Reports and Analytics  
You can use Reports and Analytics in the panel drawer to create reports and analytics about business objects.

Quickly view or run analytics and reports that are related to your work in the Reports and Analytics pane. With the
required privileges, you can also create and edit analytics and reports here.
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Edit Quality Issues and Actions  
When you open an issue or action, you can view and edit its details.

These include the general information, affected objects, related objects, attachments, comments, workflow, similar
issues, security, and history tabs.

• General Information: View basic information about the issue or action. Some fields appear with a contextual
information icon that you can click to open an information panel with more details.
The panel displays the following details:

◦ For customers - Account Description, Account Number, Registry ID, D-U-N-S Number, Country, and
Address.

◦ For suppliers - Alternate Name, Supplier Number, and D-U-N-S Number.

These additional parameters also help you search for customers and suppliers.

• Affected Objects: View, add, or remove objects affected by a specific issue or action. Affected objects can
include inventory inspections, resource inspections, receiving inspections, WIP inspections, resources, work
areas, work centers, work order operations, receipt, and items.

• Related Objects: View, add, or remove more objects related to the issue or action from either Quality
Management, Innovation Management, or Product Development.

• Attachments: Add text or graphic files, or URLs, with more information about the issue or action. You can also
classify the attachments into categories.

• Comments: Use the Comments side tab to communicate issue details, share possible root cause and
resolution, and clarify tasks. With easy access to a combined, and uncluttered view of all the user comments for
a quality issue or action, you're equipped to deal with quality processes in a quick and effective way.

• Workflow: Control the status of the quality issue or action. Add approvers and reviewers.

• Similar Issues: Analyze similar issues to resolve multiple related issues together, and to avoid replicating any
parallel efforts to resolve an issue. You can also identify trends in quality issues, the base of which may be a
broader problem and require more attention.
The Similar Issues infotile or tab automatically displays quality issues that have the same affected objects as
the current issue. Each time you update the quality issue with new affected objects, the Similar Issues infotile
is refreshed. In the Similar Issues list, click any of the quality issues to view them in detail. On the Similar Issues
infotile, the count of:

◦ Item Match: shows the number of issues that have the same affected items (affected objects of type
item).

◦ Other Matches: shows the number of issues that have the same affected objects, other than items. For
example, work order operations, resources, or inspections.
Since there can be issues that have the same items and other objects, the All or Both count isn't
necessarily equal to the sum of Item Matches and Other Matches.

• Security: Define who should have access to the object. You can search and select by Person (user name) or by
Role.

• History: View the complete history of a quality issue or action from its inception to completion on the History
side tab, without navigating to the audit reports. You can view and access audit details of a quality issue or

37



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 6
Quality Issues and Quality Actions

action for the object attributes that were configured for inclusion in Setup and Maintenance. And thus, track
when it was created, updated, or deleted easily. Remember to first enable Auditing of Issues and Actions to
see any audit log entries in the History side tab.

Related Topics
• Manage Audit Policies

Infolets for Issues and Actions  
The infolets on the quality issue edit page summarize important data about the current quality issue. Click each
category to see pertinent issues or actions.

The following infolets appear on the overview page in Quality Management:

• My Favorites: Depending on your privileges, the My Favorites infolet displays problem reports and corrective
actions.

• My Issues

• My Actions

• Open Issues by Severity

• My Open Issues by Age

• Unassigned Issues: Displays only the issues on which you can take action. Excludes issues that have no
workflow assigned or are in the Draft, Complete, and Canceled statuses from the infolet.

• Recent Activity: Depending on your privileges, the Recent Activity infolet displays problem reports and
corrective actions.

Note:   Issues and Actions in Approval status are included in the respective infolet counts.

Use Save As  
Use the Actions > Save As to create new objects based on existing objects.

For example, you can use it to create a quality action from a quality issue, copying over all attachments and affected
objects. Default or out-of-the-box attributes visible on the screen are copied to the new quality object, and the old issue
or action is automatically added as a related object. You can select both the object type and the workflow during the
Save As process. Remember that a newly created issue or action is always in the Draft status. The Description field in the
Save As dialog is read-only and the text displays in rich text format.

Note:  You can't do a Save As for production exceptions, since you can log them only from manufacturing.
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View Quality Issues and Quality Actions Graphically  
This topic describes how to view affected objects and other related objects for quality issues and quality actions using
the Graphical Navigator.

The Graphical Navigator is a read-only 360-degree view of all the relationships on a quality issue and quality action. Run
it from any quality issue or quality action, and click any object in the view for more details.

The graphical view consists of the Dependency Graph and Dependency Map.

• The dependency map lets you map the data to visualization and configure possible interaction and visual
properties. The dependency map appears in the Graphical Navigator window. The connector lines depict the
different type of connections between the components. A thick line indicates an affected objects relationship. A
dotted line indicates a related objects relationship.

• The dependency graph displays the visual cards related to the data and the relationship between the data.
The dependency graph appears in the center of the Graphical Navigator window. In the dependency graph,
when you hover over the visual card, the tooltip displays the name of the component. If the cursor is over the
attribute of the component, then the tooltip displays the attribute.

You can also click the card to view more details, and directly open the Edit page for some objects.

View Audit Trail  
An audit trail, provided for changes made to quality objects is an important function of quality controls in any regulated
industry. You can enable attributes to be logged in audit trail and view the changes in the audit report.

The audit report tracks every addition, update and removal made to the affected objects and relationships of a quality
action or issue and lists them in the report. The report also promotes accountability, enables traceability, and provides
adherence to regulatory compliance across quality issue transactions.

• The report is accessible through the side panel and displays all changes to attributes or attachments of a
quality issue, including production exceptions. Attribute changes include changes to Application Composer
attributes of a quality issue and attachment changes include creation, updates and removals.

• It also records details of who performed which change and when.

Note:  You must have the FND_VIEW_AUDIT_HISTORY_PRIV privilege to view data in the audit report.

How You Work with Quality Issues and Inspection Results
 
Here we learn how quality issues and inspection results impact each other in Quality Management.
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A quality issue is automatically created for failures during inspections of inventory, resource, or work in process. This
process helps in the early identification of nonconforming components, and enables you to take quick and necessary
corrective actions.

You can log quality issues from manufacturing or from inspections. When you do so, the impacted objects, such as work
order operations and receiving inspections are automatically added as affected objects to the quality issue. The lot and
serial number of inspected items are specified on the affected items of the quality issue (if the lot or serial is provided in
Inspection > Inspections). This helps you to quickly identify the source of the problem.

Defective Material in Receiving
Following are examples of defective material in receiving. A receiving agent can log a nonconformance quality issue for
defective material, or an out-of-spec inspection result value generated during inline or process receiving inspections.

Production Exceptions in Manufacturing
A nonconformance quality issue is automatically logged for an out-of-spec inspection result value generated during
inline or process manufacturing inspections.

You can provide the resource instance when you log production exceptions from inside manufacturing work execution.
The affected objects detail screen displays the resource instance for resources. This provides a better insight into the
specific resource instance that the exception was logged for and also enables better resource instance-specific reporting
in OTBI.

How You Work with Quality Issues, Quality Actions, and
Change Orders  
Let's have a look at how quality issues, quality actions, and change orders work together.

Quality Issues and Quality Actions
You can create and relate a new quality action from a quality issue. This copies affected objects, attachments, and some
attributes to the new quality action. You can quickly open a quality action and resolve the issue. Search for and add new
item requests in the Draft status, to the affected objects tab of a quality issue or action. You can modify the resolution
date of a quality action created from a quality issue, which has a past resolution date, after creation.

Apart from creating relationship rules from actions for related issues, you can create and relate to a quality action from
the production exception type quality issue. On the quality action Relationships tab, you can define a dependency rule
to close the quality issue upon closing the quality action. If the issue is of the production exception type, the 'Add Rule'
button doesn't appear at all and hence you can't add a dependency rule.

Note:  At all times, production exceptions are read-only in Quality Management.

Change Orders
You can define a relationship between a quality action and a quality issue, which could also be of type production
exception. A seamless approach is provided for quality and research teams to work together to manage the change
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order and resolve the impacted quality issues. You can also create relationship rules from change orders for related
quality actions.

Related Topics
• Relationships in Change Orders

Import Data Using Oracle Visual Builder Excel Add-in  
You can use the Oracle Visual Builder Excel Add-in to import objects.

This add-in allows you to edit business data available from REST services. To import each object type, you must know
its REST API URL, and required fields.

Object Type REST API URL Required Fields with Examples

Quality Issues
 

https:// <host>/fscmRestApi/
resources/11.13.18.05/qualityIssues/describe
 

• Name: Quality Issue

• Number: ISSUE135

• Organization Code: 001

• Quality Type Code: ORA_ENQ_QI_PR_
ITEM

• Severity: (Lookup Code) ORA_HIGH

Quality Actions
 

https:// <host>/fscmRestApi/
resources/11.13.18.05/qualityActions/
describe
 

• Name: Quality Action

• Number: CAPA12345

• Action Type Code: ORA_ENQ_
CORRECTIVE

• Priority: High

Before You Begin
1. Configure a quality issue type to receive new numbers through the REST APIs. To do this, set the Number

Generation Method to User-defined. You can access this task in the Setup and Maintenance work area:

◦ Offering: Product Management

◦ Functional Area: Quality Issue and Action Management

◦ Task: Manage Quality Issue Type

2. Copy the internal code of the issue type. In this example, the code is ORA_ENQ_QI_PR_ITEM.
3. Download and install the Oracle Visual Builder Add-in for Excel from the URL: https://www.oracle.com/

downloads/cloud/visual-builder-addin-downloads.html.  Note that this isn't supported in iOS.
Here we’ll look at importing quality issues of the following type:

• Issue type: Problem report

• Sub type: Item
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To import data:

1. Once you install the add-in and open Microsoft Excel, you will see the Oracle Visual Builder ribbon. To design a
sheet to import issues, click Designer. The New Layout Setup dialog appears.

2. If you've set up quality issues and actions as business objects, then you can see that quality issues is already an
object in the object catalog. To learn how to set up Business Object Catalogs, view the video: Use Visual Builder
Excel Add-in to Manage Data.

3. Select qualityIssues business object.
4. Click Next.
5. Select the Table Layout option.
6. Click Next.
7. Click Finish. Now, you've a spreadsheet for importing quality issues.

The spreadsheet lists all the fields for the selected business object. The add-in doesn’t always select the
appropriate fields as required and so you must change the list of required fields.

8. Open each of the following required fields - Number, Name, Organization Code, Quality Type Code,  and
Severity.

9. Select the Required to Create and Omit from payload if value is empty options.
10. Click Done.
11. Since these fields aren't required you can make them optional - Organization, Type, Source, and Workflow

Status. If they’re marked as required, deselect the Required to Create and Omit from payload if value is empty
options.

12. Click Redraw Layout. Verify that the required fields you chose appear with an asterisk.
13. Add data that you want to import and click Upload Changes.
14. In the Status panel, you can see the number of rows created. The Status column in the main panel shows you

the status of the upload for each row.

To validate the import, log in to your cloud instance and search for the issues you imported.

Related Topics
• Watch Video: Use Visual Builder Excel Add-in to Manage Data.

Workflows for Quality Issues and Actions  

Workflow Status  
This topic describes how workflows ensure a standard and repeatable process for managing quality issues and quality
actions.

A workflow is a sequence of steps that a quality issue or quality action follows as it goes through a business process.
Quality teams and interested parties can track the progress of a quality event through its workflow status.

You can't edit the quality event when it's in a read-only state like Approval or Closed. When the Approval status of a
workflow is rejected, the workflow infotile displays the following message, 'Rejected by' <user name>.
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Predefined Statuses
The workflow of a quality issue is based on how it's used. A quality issue workflow can be any of the following default
workflows or one that your administrator creates. These are the pre-defined statuses through which a workflow
progresses.

• Issue expedite workflow - Draft, Open, Closed.

• Issue workflow with review - Draft, Open, In Process, Closed.

• Issue workflow with approval - Draft, Open, In Process, Approval, Closed.

• Issue resolution - Draft, Open, Review, Containment, In Process, Remove Containment, Closed.

• Issue exception - Draft, Open, Closed.

• Issue workflow with preapproval and approval - Draft, Open, Initial Approval, Issue Resolution, Final Approval,
Closed.

The figure shows the workflow statuses of the default quality issue workflows, based on usage.

43



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 6
Quality Issues and Quality Actions

The workflow of a quality action is also based on how it's used. A quality action workflow can be any of the following
ready-to-use workflows or additional ones that you define. These are the predefined statuses through which a workflow
progresses.

• Action expedite workflow - Draft, Open, Closed.

• Action workflow with review - Draft, Open, In Process, Closed.

• Action workflow with approval - Draft, Open, In Process, Approval, Closed.

• CAPA workflow - Draft, Open, In Process, Root Cause, Solution Design, Solution Plan, Validate, Closed.

• Action workflow with preapproval and approval - Draft, Open, Initial Approval, Action Resolution, Final
Approval, Closed.
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• 8D workflow - Draft, D0: Plan, D1: Form Team, D2: Define Problem, D3: Interim Containment, D4: Determine
Root Cause, D5: Verify Connections, D6: Implement Corrective Actions, D7: Preventive Recurrence, D8:
Congratulate Team, Closed.

The figure shows the workflow statuses of the default quality action workflows, based on usage.

Workflow tasks are withdrawn automatically if they're not used in 180 days or more. Once this happens, you can no
longer modify the quality issue or action.

This threshold is set in the Open Tasks Withdrawn after Number of Days field on the Application Preferences
page in the following location: BPM Worklist > Administration > Application Preferences. You can change this only by
modifying the expiration settings in the Deadlines subtab within the Task Configuration tab for the workflow task. The
task level expiration setting takes precedence over the automatic withdrawal setting of 180 days.
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Advanced Search to Add Users to Quality Object Workflows
Use the Advanced Search to search for and assign approvers to workflows of quality issues and actions. Search
operators such as Starts With, Ends With, Equals, and Contains support the feature while allowing additional search
fields such as Email or Name, within the search, for selecting approvers. This provides flexibility and an additional
means to search for and find the required approvers for a quality issue or action approval. The approvers and security
search results lists for quality issues and actions display not only the name but the user name and email.

Approve or Reject a Quality Object  
When a quality issue or action is sent for approval, a notification appears in the bell notifications list.

To have a quick look at your open in-app notifications and act on them, you can scroll to the Things to Finish section of
your home page. You can choose to approve or reject the issue from both these locations. You can choose to approve or
reject the issue or ask for more information.

To approve or reject a quality object:

1. Click the Notifications icon.
2. Select and click the appropriate Action Required from the Pending Notifications list.
3. Click the Create icon, enter comments in the dialog box, and click OK. If comments are compulsory, you must

enter a comment before you approve or reject.

Note:  Comments for approval or rejection are compulsory or optional as set by your administrator.

4. To ask for more information before you approve or reject, select the Request Information option from
the Actions menu on the notification. In the dialog box that opens, you can select who should respond -
Participants or Other Users. You can also specify whether the information must be routed directly to you or if
later participants must retake action based on this information.

5. Click Approve or Reject.
Comments added while approving or rejecting appear on the Approvers table of the corresponding quality issue or
action.

Workflows help you route notifications to the approvers, and document their feedback. For quality objects, you can
configure default approvers, and you can add approvers manually as you advance the object through its workflow. If
you enable the Signature Password Required feature on issues and actions, ensure that you provide the user name
and password during approval.

Note:  Only if there's a status or statuses prior to the workflow status that you're in can you demote a workflow and it
goes back to the prior status.

Terminate and Restart Workflows  
If an approval workflow in a quality action or issue stops or gets stuck, you can terminate and restart the approval
workflow, while it's still in the approval status or interim approval status.

An approval workflow is usually stuck if the quality issue or action approval requires correction of the approvers and
hence can't proceed with the approval.
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Use the Terminate Workflow action from the Actions menu to terminate the workflow approval. The quality object
remains in the same status and you can either manually demote the issue or action to a previous status or restart it
from the same status. (If you've configured the workflow template to auto demote its status to Draft, then it changes
to the Draft status. If not, it stays in the same status). This action is only available for the Assignee of the quality object
or the Submitter (if the Assignee field is empty), who must also have the Manage Issue or Action privilege. Pending
approval notifications remain in the BPM Worklist and the bell notification, but you can't act upon them after you
terminate the workflow as the Approve and Reject buttons disappear from the notification. When you resubmit the
workflow for approval, you will receive a new active notification with active Approve and Reject buttons.

Note:  Providing a comment while terminating and restarting the workflow is required.

You can modify the list of approvers and restart the workflow. Use the Restart Workflow option from the Actions
menu. The workflow restarts from the current status it's in and new approval notifications are sent. For example: If you
terminate a workflow in Approval status and then demote it to the In Progress status, when you restart the workflow, it
will be from the In Progress status and not from the Approval status.

Notifications  
You will receive email notifications when workflow tasks are assigned to you.

As the quality issue or action advances through a workflow, notifications are sent to inform participants about the
occurrence of different events and actions you must take. You will receive notifications for each task you're assigned
to, either by email or through the bell notification. You can access the in-app notifications either in the Things to Finish
section on the home page or the notifications list in the global header.

Use the Send action to notify other users about an issue or action. Select users from the list in the Send dialog box
and add a message to the notification to help solve issues. In addition to users, you can add roles as recipients in
Send notifications. It's recommended to send notifications to roles and not to many users. Once you expand roles to
display the list of its members, you can further refine the list manually to include only the users you want to notify. Send
notifications and notify large groups of stakeholders or approvers and ensure faster cross-functional collaboration. Add
all recipients within a role quickly, instead of adding them one by one, thus improving user experience. Notifications are
sent to all users and to the users of the role that isn't expanded in the recipient list. Notifications also display the Sent
By field to help you identify the user who sent it. This eliminates delays and improves time to response. Assignees will
receive an FYI notification and optionally an FYI notification email.

Related Topics
• View Product Management Notifications

Create and Manage Quality Issues and Actions  

About Working with Quality Issues and Actions  
Quality actions help to correct and prevent future occurrences of the issue.

If you can't resolve a quality issue quickly, use a quality action to conduct a more thorough investigation of the problem
and a possible resolution. You can create, edit and mark quality actions as favorites to find them easily later. Using the
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Actions menu, create a quality action from a quality issue. This process automatically links the quality action to the
quality issue and copies attachments and affected objects from the quality issue. You can also create change orders that
link to the current quality action, to track the resolution of an issue. Let's see how you can create and manage quality
issues to study problems in a controlled manner.

1. Navigate to the Quality Management work area. On the Overview page, select Quality Issue from the Create
menu.

2. Select the type of quality issue you're creating from the Type menu.
3. Enter a name in the Name field and briefly describe the problem in the Description field.
4. Search for the Organization from the Organization list.
5. Select the Severity and the Source of the issue.
6. Select the appropriate Workflow to route the issue.
7. Click Save and Close.

You can add affected objects after you create a quality issue. The Affected objects tab lists the following types - All,
Inspections, Resources, Work Areas, Work Centers, Work Order Operations, Receipts, and Items.

Note:  The Quality Issues Relationships infotile of affected objects lets you search for and add only items as affected
objects. However, on related objects, you can add other object types as well.

Actions Menu in Quality Management  
The Actions menu items of quality objects help you modify and obtain more details about the object.

• Send: enables you to notify other users about an issue or action. Select users from the list in the Send dialog
box and add a message to the notification, if required, to help solve issues.

• Launch Graphical Navigator: opens a graphical display of the business object and its related objects.

• Create Quality Action: creates quality actions that link to the quality issue you're working on. Since affected
objects and attachments are copied over from the issue, the quality action gets the same affected objects and
attachments as the quality issue from which it's created.

• Create Change Order: creates a change order where you can define how you intend to resolve the issue. The
change order automatically includes a relationship link to the quality issue or action from which it's created.

• Cancel Quality Action or Issue: cancels the workflow of an action or issue in any state, other than Closed.

• Delete: deletes the selected quality issue or action. Remember that you can't delete nonconformance object
types.

• Terminate Workflow: terminates the workflow of an approval workflow in a quality issue or action.

Assign Organizations to Quality Objects  
You can assign a specific organization to a quality action or issue during its creation or later with the Organization
attribute on the quality action or issue.

Only users who are assigned to that organization can see quality actions or issues specific to the organization. You can
also filter quality actions or issues by organization in searches.
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By assigning an organization to a quality action or issue, you can streamline the process flow to define the primary
location where the quality action or issue must be executed. It also simplifies your view by restricting the visibility of
quality actions or issues to users from the assigned organization.

Related Topics
• Watch Video: Restrict Available Objects Through Configured Roles

Create a Quality Action from a Quality Issue  
Creating a quality action from a quality issue links the action automatically to the issue. Quality actions help to correct
and prevent future occurrences of the issue.

If you can't resolve a quality issue quickly, use a quality action to conduct a more thorough investigation of the problem
and a possible resolution.

Here's how you create a quality action from a quality issue.

1. Navigate to the Quality Management work area.
2. Open an existing issue or select an issue from the Search panel.

Note:   If you mark an object as a favorite, you can use the Favorites list to find it easily.

3. From the Actions list of the issue, select Create Quality Action.

◦ Depending on the type of action, you want to perform, select a Type.

◦ In the Name field, enter a name for the quality action.

◦ In the Description field, enter a brief description.

◦ Select a workflow.

◦ Click Save and Close.

4. Click the Relationships infotile. In the Affected Objects tab, the item on the quality issue automatically appears
as an affected object. Attachments, if any, are also copied to the quality action.

5. Note that the quality issue appears as a related object in the Relationships tab.
6. Click the Add icon of the quality issue in the Related Objects tab. A relationship rule between the issue and

action is created, such that when the issue is closed, the action closes automatically.
7. Click Save.
8. To move to the next status in the workflow, click Change Status.

You can change the resolution date of a quality action created from a quality issue, which has a past resolution date,
after creation.

Related Topics
• Watch Video: Create an Action from an Issue
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Create a Change Order from a Quality Action  
You can manage change orders to take actions on impacted quality issues. This topic describes how to create a change
order from a quality action.

1. Navigate to the Quality Management work area.
2. Search for and open a quality action. Or, open a quality action from the Favorites menu.

◦ From the Actions list, select Create Change Order.

◦ Select a change order type from the list.

◦ Enter a number in the Number field.

◦ In the Name field, enter a name for the change order.

◦ In the Description field, enter a brief description of the change order.

◦ Click Save and Edit.

The change order appears as a related object on the Relationships infotile of the quality action.
3. Click Relationships and then click the change order to open it.
4. Within the change order, click the Affected Objects tab.
5. Click Add Item  and search for the item that you want to change.
6. Mark or redline changes to the item. Redlining is the process of modifying a product structure using a change

order.
7. Click the Relationships tab on the change order. In the window that opens, set a rule to close the quality action

on completion of the related change order.
8. In the related quality action, click Select and Add. A Relationship rule moves an object automatically to the

next status of the workflow when a related object advances to its specified status. Dependency rules can be set
only for next statuses that are allowed in the workflow. For example, if 'Closed' isn't one of the status allowed at
this point in the workflow, you can't move the object to that status.

9. Using the lists on the window create a rule such as: When change order XYZ is Completed, set Quality Action
ABC to Closed.

10. Click OK.
11. Click Save and Close.

Related Topics
• Watch Video: Create a Change Order from an Action

Create and Route a Quality Issue  
Quality issues report variations or defects that occur in the performance of a product. This topic describes how you
create and route a quality issue.

1. Navigate to the Quality Management work area.
2. Go to the Create menu and select the Quality Issue option. For issues relating to a problem with an item, select

a quality issue of the problem report type.

◦ In the Name field, enter a name for your issue.
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◦ In the Description field, describe your problem briefly.

◦ Search for and find the appropriate organization where the issue occurred.

◦ Select values in the Severity  and Source fields.

◦ Click the Workflow infotile and select a workflow.

◦ Click Save and Close. The issue opens on the General Information page.

3. Click open the Relationships infotile and click the Affected Objects side tab.
4. Click Select and Add.
5. Search for and add the affected object that has a problem and click Done.
6. Click Save. The Relationships infotile refreshes to indicate the issue has an affected object.
7. To route the issue, click Change Status or click the Workflow infotile.

Related Topics
• Watch Video: Create and Route an Issue

Manage Attachments for Quality Objects  
You can include various files, URLs and images as attachments to quicken the resolution of quality actions or issues.

You've two options to add an attachment - click the Add Attachment option from the Actions menu or click the + icon
on the Attachments page. You can also:

• Add multiple file attachments

• Check in and check out attachments

• Manage attachment revisions

Use the filter and sort attachments (by ascending or descending order) to quickly find a specific attachment. View
revision date and track the history of who last updated an attachment and when. Use Direct Edit to edit attachment
attributes such as Title, Description, Category and more in the Attachments table. You can also track and access
attachment revisions.

View the attachments in a table, list or grid view. You've 'the option to download, delete, view File Revision history and
attachment details for each row of the attachment. The Attachment table lists the contents and opens the highlighted
row in the side panel, where you can change details and save the attachment edits.

To delete an attachment, you either click the Delete icon X, which is enabled on selecting the row or select the Delete
option from the Actions menu.

Related Topics
• Configure Attachment Categories

Add Attachments to Quality Objects  
Attachments aid in providing additional information to resolve the issue and can be in the form of files, text or URLs.
You can add multiple file attachments with the Add action.

1. Navigate to the Quality Management work area.
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2. On the Overview page,

◦ Search for quality issues or actions, if you've saved any.

◦ Click the Favorites and Recent Items icon to search for any favorite issues or actions.

◦ Create a quality issue or action from the Create list.

The quality issue or action opens on the General Information page.
3. Click the Details infotile.
4. Click Attachments > Add Attachment.
5. From the Add Attachments pane, select an Attachment Type, say Files, and a Category from the lists.
6. Click Choose Files and select the required file or multiple files.
7. Click Save. Notice that the Details infotile shows another attachment. You've options to download the

attachment, delete it or view its contents in detail.
8. Select the attachment row, and click the Details icon.
9. To replace the file, click Choose Files. Select the required file and click OK.

10. Click Update.

Relationships in Quality Objects  
Let's see how quality issues and actions work with affected objects, related objects, Innovation Management and
Product Development.

Affected Objects
The affected objects screen provides a summary of all the affected objects involved with a specific issue or action. You
can view details of the object and gain more insights into why something has happened. When you log quality issues
from Manufacturing or from Inspections, affected objects are automatically added to the issue.

Add items appearing in the search results of other organizations as affected objects on quality issues and actions and
remember that, access to these organizations is required for this. The functionality is applicable to nonengineering
items too.

Related Objects
The Related Objects tab in the Edit Quality Issue and Edit Quality Action pages lists objects that are related to the
current issue or action. These objects can be from Quality Management, Innovation Management, or Product
Development. Related objects are the primary means of relating quality issues to quality actions and change orders
through dependency rules.

Problem reports and corrective actions that are based on change types also have a Relationships tab where you can add
related objects and create dependencies between objects. For more information, see Relationship Rules for Changes,
Problem Reports, and Corrective Actions

Relationship Rules for Quality Issues and Actions
Use the Relationship rules or Dependency rules to move an object automatically in its workflow, when the related object
moves to its specific status. Relationship rules can close a quality issue upon the closure of its related quality action. It
can also close a quality action upon implementation of a related change order.

Use relationship rules to define and manage relationships between quality issues, quality actions, and change orders.
Define rules to change the status of one object when the status of a related object is changed to a specific value. For
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example, you can define that the status of a quality action is set to Closed once the related change order is set to
Closed. You can clearly view the status set for each object.

• Manage privilege on the source objects is required to set rules for those objects. Remember that without this
privilege, you can't open the rule editor.

• You can create a rule only if both related objects have a workflow assigned.

The Relationship rule can only change the status of a target object if the workflow allows it and the rule is applicable
only if the target status is the next status of this object. For example, the Relationship rule can't promote an issue from
Draft to Closed, if it isn't defined in the workflow.

Note:  Don't use the Relationship rule to promote an issue or action to an approval status, if the approvers aren't
manually or by default in the approver status in Setup and Maintenance.

FAQs on Quality Issues and Actions  

What happens if you cancel a quality issue or action?  
On cancellation, you're asked to confirm the cancellation and provide a comment. The Cancel action terminates the
workflow in the current status and it moves directly to a Canceled substatus, indicated in the workflow summary with an
X icon.

If the canceled issue or action is assigned a workflow, FYI notifications are sent to the creator, assignee and the person
canceling the workflow. Even though the issue or action is canceled, you can still perform the following actions - Save
As, Send and Launch Graphical Navigator. You can still add comments in the Comments side tab.

Can you search for a canceled issue or action?  
Yes, you can search for a canceled issue or action. Navigate to the issue or action. Using the Search side tab, filter by
Status Type - Canceled. The canceled issue or action appears in the search results.

How can I quickly add items to quality issues and actions?  
Use the Clipboard panel tab in the Quality Management work area to add affected items and related objects to your
quality issues ad actions.

You can copy and paste, drag and drop or move multiple items from the clipboard into the Affected Objects table or the
Relationships table of an issue or action. The contents of the clipboard are retained when you sign out of the application
and sign back in. You can also do this from the Favorites and Recent Items tabs next to the Clipboard tab.
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How can I copy items from Product Development into Quality
Management?  
Clipboard entries are shared across all Product Management work areas. When you copy an item in the Product
Development work area, it's automatically available on the clipboard within the Quality Management work area.

How can I create a quality issue or action from an item?  
Use the Create Quality Issue or Create Quality Action option from the Actions menu of an item to create a quality issue
or action. Once created, the quality issue or action is automatically related to the affected item.

Who has access to my quality issue or action?  
In addition to the users and roles in the Security list, by default, the creator and the assignee can always access the
quality issues or actions. The Security tab automatically displays the creator and assignee.

Why can't I update the quality issue or action that's assigned to
me?  
Your administrator may have configured the workflow to disallow updates to the issue or action in its current status.

The ability to update an issue or action in each status is controlled by the Allow Updates setting for that status in the
workflow template.
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7  Set Up Quality Issues and Quality Actions

Secure Access to Quality Issues and Actions  
This topic describes how security is supported in Oracle Quality Management. Use the Security side tab on issues and
actions to add users and roles who can view and search for issues or actions.

Security is applied at two levels:

• Functional Security

• Data Security

Functional Security

Functional security defines the functions you can perform and the pages and objects you can access. For example, it
defines who can

• enter the quality management work area

• create a quality action

• create a quality issue

The two types of privileges in Quality Management are:

• Manage - lets you create and edit issues and actions

• Review - provides a read-only view of the issues and actions.

Functional security in Quality Management is based on the following privileges:

• Manage Quality Action - (ENQ_MANAGE_QUALITY_ACTION_PRIV)

• Review Quality Action - (ENQ_REVIEW_QUALITY_ACTION_PRIV)

• Manage Quality Issue - (ENQ_MANAGE_QUALITY_ISSUE_PRIV)

• Review Quality Issue -(ENQ_REVIEW_QUALITY_ISSUE_PRIV)

You can assign these privileges only to the user roles, and not directly to the user.

For example, assign John Smith with a quality analyst role (that contains the Manage Quality Action, Review Quality
Action, Manage Quality Issue, Review Quality Issue privileges) to create and edit quality issues and actions. The two
privileges are assigned to specific task flows and menu actions.

While setting up functional security, consider:

• the privileges assigned and the user roles to which they're assigned

• the users, the functions they can perform, and the functionality and work areas they can access

Oracle delivers some users, user roles, and privileges which are ready to be used. The users and user roles can be
adapted and assigned respective privileges.

Data Security

Data security defines access to specific data (records) and is applied in addition to functional security. For example,
even though you can create and manage quality issues (functional security) as a user you may not see the quality issue
"ISSUE46", because the data record isn't visible for your user role (data security).
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To enable Data security, you can:

• define data security grants for accessing the issue and action tables for specific user actions

• define data security grants for editing in the issue and action Security tab

• define which users and roles can access a specific issue or action by adding them to the Security tab of the
issue or action

• define which user can see which quality issues based on inventory organization assignment

• grant permissions to perform changes depending on the status of the object.

Data Security Grants on Tables

Data Security grants on the issue and action tables define each user role. All the users who need to see, update or
delete issues and actions, need to be assigned to a user role that grants them access to these data tables with the
corresponding user action.

You can grant overall access to the issue and action table, or access to specific user actions like Read or Update.

Note:  Data security grants can't be defined for the creation of issues and actions, as the data doesn't yet exist. Hence,
creation can only be allowed or prevented through functional security.

Data Security Grants on Application Objects

Data security grants are essential to add and remove users and roles on the Security tab of issues and actions. Hence,
you require an additional data grant for application objects on the table FND_OBJECTS for issues and actions.

Data Security Grants Based on Users and Roles on Security Side Tab

The Security side tab for issues and actions makes previously public issues and actions private by assigning them to
specific users and roles.

After you add the first user and user role to the Security tab, only respective users and user roles (user assigned to these
user roles) have access to these issues and actions. In addition, the Creator and Assignee are automatically granted the
privilege to see the issues and actions.

Permissions to Perform Changes Based on the Object Status

Depending on the type of data, you can restrict the user from editing the issue or action even if the appropriate
privileges and grants are available. For example, if the quality issue or action is:

• logged as Production Exception

• logged as Inspection Nonconformance

• in a state which prevents editing

You can't edit a record or its relationships; this is to prevent any inconsistencies between production exceptions that you
log in manufacturing and the respective quality issues.

You can't delete inspection nonconformances, but you can perform most editing operations.

You can't edit quality issues and actions if they're in certain states, such as waiting for approval, or after approval and
closure. This ensures that other quality users can rely on the fact that's issues and actions that they approve or have
approved, won't change.

Visibility of Quality Actions and Issues Based on Inventory Organization Assignment

You can assign a specific organization to a quality action or issue to identify where the issue or action has occurred.
Note that users who need to create or access quality issues or actions for an inventory organization must also be
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assigned to that organization. You can do this using the Manage Data Access for Users task in the Setup and
Maintenance work area.

If you're using configured job roles to access quality objects, ensure that these job roles are assigned to the appropriate
data security policies in the Security Console, specifically Grant on Inventory Organization.

The following data security function must be entered for user-defined roles in the Security Console for the Quality
Actions Data privileges:

• Policy Name: Grant on Inventory Organization

• Database Resource: Inventory Organization

• Dataset: Select by Instance Set

• Condition Name: Access the inventory organization parameter for table INV_ORG_PARAMETERS for the
inventory organizations in which they can operate.

• Actions: Manage Quality Organization

Access to Affected and Related Objects

You can add items, manufacturing work order operations, manufacturing resources as affected objects to quality issues
and actions. Relate Oracle Innovation Management and Product Development objects like ideas, requirements and
change orders to the quality issue and action.

Functional and data securities govern quality issues and actions. So, even though you can view a related idea or an
affected item, you can't open it unless you've the appropriate privileges.

For example, to open and see the details of an affected item, you not only are required to have functional privileges to
view and manage the item but also have data security grants to the inventory organization.

User and Role Data Security

The security side tab on issues and actions enables you to add users and roles who can view and find this issue or
action.

The creator and assignees can automatically access the issue or action. Users not listed on the security tab can't find or
view the issue or action.

Related Topics
• Restrict Available Objects Through Configured Roles

Configure Quality Object Types  
Here's how you set up quality object types. These are created as subtypes of an existing quality type.

1. Navigate to the Setup and Maintenance work area.
2. From the Product Management offering, click the Quality Issue and Action Management functional area.
3. The Manage Quality Issue Types and Manage Quality Action Types tasks appear. Select and click one of

them. For example, select Manage Quality Issue Types.
4. In the Create Quality Issue Type dialog, click the Actions Menu. Use the New, Edit, and Delete icons to create

more object types and make changes.
5. Select the New button to create a subtype of the existing quality issue type.
6. Enter field values in the Create Quality Type dialog box.
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◦ Name: the title that the administrator can see

◦ Label: the title that the users can see

◦ Source: the default source of where the issue came from

◦ Object Creation Allowed: set to Yes or No to define if users can see this type in the Create menu

◦ Code: an internal unique identifier for the object

◦ Description: describes the purpose of this type to the administrator.

7. Click Save and Close.
You've successfully configured a quality issue type.

Remember to check if issue and action types are in use before you delete them. On selecting a quality issue or action
type that's in use, an error message informs you that you can't delete it because it's already in use. Also, the Delete icon
is automatically disabled on selecting a row of the type that you can't delete.

Configure Default Assignee for Quality Issues and
Actions  
Configure a user as a default assignee during object type setup for quality action and issue types in the Setup and
Maintenance work area.

When you create a quality action or issue of a specific object type, the user, by default, is added as the assignee while
creating:

• quality issues or actions in the Quality Management work area

• quality objects from item in the Product Development work area

• quality actions from issues

• objects through REST APIs

Any quality issue or action type created is assigned to the user selected in the Assigned To field. The specific owner is
notified of approvals, specific status changes, and can track the object for quick resolution.

Configure Attachment Categories  
When you add an attachment to an issue or action, select the appropriate category to indicate the kind of attachment
you intend to add.

When you use the Save As action to create a new issue or action, attachment category details are carried over to the
new issue or action along with the attachments.

Note:  You need an administrator role to manage the attachment categories and their assignment to the issue or
action attachment entities.
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To assign additional attachment categories for quality issues and actions:

1. Navigate to the Setup and Maintenance work area.
2. Open the task Manage Attachment Entities.
3. Search for the entity ENQ_ACTION (Quality Actions) or ENQ_ISSUE (Quality Issues).
4. Select the entity to see the attachment categories assigned to that specific entity.
5. Add the additional attachment categories that must be made available for selection when you create

attachments.
You can create attachments and associate them to the categories in the attachments table of issues and actions. By
default, only the Miscellaneous attachment category is assigned for quality issues and actions.

Quality Management Objects You Can Audit  
You can choose from a list of existing or configured objects and include them in the audit.

The following table lists objects in the Quality Management work area that you can enable for auditing.

Audit Attributes

Quality Issue
 

• Quality Issue

• Quality Issue Attachment

• Quality Issue Affected Object

• Destination Quality Issue

• Source Quality Issue

 

Quality Action
 

• Quality Action

• Quality Action Attachment

• Quality Action Affected Object

• Destination Quality Action

• Source Quality Action

 

Configure User Display Format  
You can configure how users are displayed on the interface by choosing a user name display format in the Setup and
Maintenance work area.

Use the Manage Administrator Profile Values task to configure the user name display format.

59



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 7
Set Up Quality Issues and Quality Actions

Profile Option Setting for User Display

Profile Option Description

ORA_EGP_NAME_DISPLAY_MODE Specifies how users are displayed on the user interface.
 
You can select your preferred display format. The options are:

• User Name - Example: Jane.Doe

• Email - Example: jdoe@abc.com

• Name - Example: Jane Doe

Note:
The Name format is derived from the Display Name setting configured using the Manage Person
Name Formats task in the Setup and Maintenance work area.
 

 

The default format for user display is applied on all pages and tabs, except the Attachments tab. The Attachments tab
always displays users in the User Name format. If you haven't configured Email, First Name, and Last Name, then the
User Name is displayed.

Configure Number Generation  

Set Up Autonumbering Schema for Quality Objects  
Number generation is the process of generating numbers for objects that you create. Organizations can define their
own number range to suit specific requirements.

Number generation methods are predefined by the administrator and you, as an administrator, can configure the
autonumber schema for each quality object type. Choose either the User-defined or the Sequence generated method
while creating a quality issue or action type.

• In the User-defined method, the field is editable and you, as the user, can type in the number. A message and a
highlighted number field warn you if a conflict arises. You then type in another number.

• In the Sequence-generated method, the number field is pre-populated and non-editable. If the number already
exists or you cancel the creation of the quality issue, the number is used up. For the next issue or action you
create, the number, according to the sequence chosen, is automatically generated. The application continues
to generate the next numbers until there's no conflict or the pre-defined maximum number of attempts limit
is met. If you don't generate a number within this limit, the last generated number displays with a warning
message and you can only cancel the creation of the quality object.

All the quality issue and action types let you set the number generation method. For the root quality issue and action
types, you've only the user-defined and sequence-generated options and not the Inherited from Parent option. When
you select the sequence-generated method, provide the Prefix, Suffix and Increment Number Range for auto-number
schemas and assign them to the existing type of quality issue or action that you create.
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How You Set Up Number Generation  
Let's set up a method to generate numbers for a quality issue or action type. Remember that you must either be a
Supply Chain Application Administrator or an Application Implementation Consultant to proceed with this task.

1. Navigate to the Setup and Maintenance  work area.
2. From the Product Management offering click the Quality Issue and Action Management functional area.
3. The Manage Quality Issue Types and Manage Quality Action Types tasks appear. Select Manage Quality

Issue Types.
4. Select the New button to create a subtype of the existing quality issue type.
5. Enter field values in the Create Quality Type dialog box.

◦ Name: the title that the administrator can see

◦ Label: the title the users can see

◦ Source: the default source of where the issue came from

◦ Object Creation Allowed: set to Yes or No to define if users can see this type in the Create menu

◦ Code: an internal unique identifier to the object

◦ Description: describes the purpose of this type to the administrator.

6. Click Save and Close.

Now that you have successfully created a quality issue type, you can move on to defining a number generation
method.

7. Click the Edit icon to open the Edit Quality Action Type page.

a. In the Number Generation Method field, select an option to define the method that will appear in the
quality issue type.

- Inherited from the Parent: inherits the method from the parent object.
- User-defined: lets you, as the user, type in the number you want to, at the time of creation.
- Sequence-generated: the values appear in a specified sequence defined by the increment. On

selecting the Sequence-generated option, enter values for:

◦ Prefix: text that automatically appears before the number

◦ Suffix: text that automatically appears after the number

◦ Starting Number: the number you start with

◦ Increment: the number you want to set the increment by

◦ Maximum Number of Attempts: the number of attempts the application must attempt to
autogenerate a unique number.

Remember that every time you change the required values, the numbering sequence is reset
to start from the starting number. To continue with the next number (before your update in
the sequence-generation set up), you must note and enter the next number as the starting
number.

b. Click Save and Close.
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After you configure the method to generate the numbers, the quality objects that you create display the numbers based
on the type of quality issue or action that you choose.

Note:  Manufacturing and Inspections use internal APIs to create exceptions and non-conformances. If you (as the
administrator) set respective types to the User-defined or Inherited from parent options, the process of creating them
can fail through the internal APIs. So, ensure that you use these settings ONLY for legacy data import - if at all. Oracle
recommends to always set them to Sequence-generated.

Configure Quality Event Lookups  
This topic describes how to set up quality issues and quality actions lookup values in the Setup and Maintenance work
area.

The Setup and Maintenance work area provides tasks for configuring and enabling modules in Oracle
Cloud Applications. In Setup and Maintenance, search for the Manage Quality Issue and Action Lookups
task. The Manage Quality Issue and Action Lookups task requires the Setup Product Quality privilege
(ENQ_SETUP_PRODUCT_QUALITY_PRIV).

Lookup types with the configuration level System don't let you add or delete lookup codes. However, you can edit the
Meaning and Description fields of the existing lookup codes. The following lookup types exist but aren't used.

1. ORA_ENQ_ASSOCIATION_TYPE
2. ORA_ENQ_AFFECTED_OBJECT_TYPE

The following table details the lookups available in Quality Management.

Module Lookup Type Lookup Code Meaning Description Configuration Level

Issues
 

ORA_ENQ_DISPOSITION
 

Quality Disposition Type
 

The various designations
or classifications that are
available for you to assign
to a quality issue to resolve
the issue.
 

User
 

Issues
 

ORA_ENQ_SEVERITY
 

Quality Issue Severity
 

The level or degree of the
quality issue for you to
prioritize when and how to
resolve the issue.
 

User
 

Actions
 

ORA_ENQ_PRIORITY
 

Quality Action Priority
 

The rank of the quality
action to decide when and
how to resolve an issue.
 

System
 

Common
 

ORA_ENQ_AFFECTED_
OBJECT_STATUS
 

Affected Object Status
 

The possible stages to set
for an affected object.
 

System
 

Common
 

ORA_ENQ_IMPACT_TYPE
 

Affected Object Quality
Issue Impact Type
 

The level of involvement
that the quality issue or
action affects the object.
 

System
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Module Lookup Type Lookup Code Meaning Description Configuration Level

Common
 

ORA_ENQ_LIKE_OF_
RECURNCE
 

Likelihood of recurrence
 

The level of likelihood of
recurrence of the quality
issues and actions.
 

User
 

Common
 

ORA_ENQ_OBJECT_
STATUS
 

Quality Object Status
 

The possible stages to set
for a quality object.
 

System
 

Common
 

ORA_ENQ_OBJECT_TYPE
 

Quality Object Type
 

The different classifications
available for quality objects.
 

System
 

Common
 

ORA_ENQ_SOURCE
 

Quality Source
 

The area of the business
process where the quality
issue originated from or
where the proposed action
must occur.
 

User
 

Common
 

ORA_ENQ_SUPPORTED
ENTITIES
 

Supported Entities for
Quality Type
 

Indicates the Supported
Entry for Quality Type
 

System
 

Common
 

ORA_ENQ_YES_NO
 

Generic Yes and No List of
Values
 

The available Yes and No
options.
 

System
 

Configure Workflows  

Workflow Templates  
This topic discusses how you can define workflow templates for a quality action or issue.

Apart from defining workflow templates for Quality Management in the Setup and Maintenance work area, you can also
create, edit, view, duplicate and search for them.

To create a workflow template:

1. Navigate to the Setup and Maintenance work area.
2. Select Product Management from the Setup menu.
3. From the list of Functional Areas, click Quality Issue and Action Management.
4. From the list of Tasks, click Manage Workflow Templates for Product Lifecycle Management.
5. From the Actions menu, click Create to create a workflow template.

You can define multiple statuses, but you will derive them from the following standard status types:

• Open

• Interim Approval

• Approval

• Completed
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The Approval Details panel appears only for the Approval and Interim Approval status type and not for the Open,
Scheduled and Completed status types. You can edit the status sequences and approval details of a workflow template.
For the Approval and Interim Approval status, define Ready-to-use approvers and optional approvers. The list of the
approvers appear in a table-view. Select One for a single approver and All for all the approvers in the Reviewers list,
to approve the workflow. Duplicating a workflow template copies the Workflow Status and the Status Details table.
Notifications are sent to approvers, when the workflow reaches a certain status or on its approval or rejection. You can
also export the workflow templates to an Excel sheet.

Note:  In Quality Management, predefined workflow templates are read-only. However, the end date is editable to
enable deactivation of the predefined workflow template.

Workflow Status Sequences  
When you define statuses in a workflow template, you can set the sequence of the statuses in the workflow. The
sequence you set reflects the order in which the statuses appear on the user interface.

On initiating a workflow, the quality issue or action moves either to the next or the previous status, based on the
sequence of the statuses. Specifying autopromote and autodemote settings for a workflow status automatically
executes promotion and demotion of the workflow.

An approval step can follow another approval step if you're manually promoting the object from one status to another. If
autopromote is set up, this isn't recommended because approvers for the second step may be not added yet.

If the object is rejected at a certain status in the workflow, you can only demote it. You can change status to any status
defined in the workflow, as long as its sequence number is lower than that of the current status.

Note:  When you assign a workflow to an issue or action, after defining a workflow template, it moves from the Draft
status to the first status (mostly Open). That's when the workflow template is copied into the workflow instance
for that specific issue or action. Any future changes to the workflow template doesn't affect the workflow instance.
Workflow instances follow defined workflow templates. Ensure that you define the workflow template in the sequence
you want it to appear. The order that's set in the workflow template at the time of kicking off the workflow is the
sequence that will show in the workflow instance.

Create a Workflow  
Here's how you create a quality management workflow. You must either be a Supply Chain Application Administrator or
an Application Implementation Consultant to do this task.

In the Setup and Maintenance work area navigate to the following:

• Offering: Product Management

• Functional area: Quality Issue and Action Management.
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• Task: Manage Workflow Statuses for Product Lifecycle Management

1. Click Create (+) to create a workflow status. In the Create Workflow Status dialog box, enter the required values.

a. Enter a name in the Status field - For example: Executive Approval.

i. Select a type from the Status Type menu. For example: Approval. You can choose a type from the
following options: Open, Interim Approval, Approval, Completed.

ii. Give a brief description in the Description field.
iii. Click Save and Close.

b. Click Save and Close to sign out from the Manage Workflow Statuses for Product Lifecycle Management.
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2. In the Task pane, click the Manage Workflow Templates for Product Lifecycle Management task.

a. Click Create(+) to create a workflow template or duplicate an existing template. In the Edit Workflow
Template page, fill in the required values.

i. Enter a name in the Name field. For example: Executive Approval Workflow.
ii. The Internal Name field is automatically filled.

iii. Enter a brief description in the Description field.
iv. Select an object from the Applicable To menu to which the template is applicable (in this example

select Quality Issue).
b. In the Workflow Status Sequence panel, click Create (+) to add a status to the sequence. Add multiple

different statuses to the sequence to create a workflow template.

i. Enter values in the Sequence Number field to set a sequence. For example: 10, 20, 30.
ii. Select a value for the Status field. For example: Open, Executive Approval, Completed.

The Status Type field is automatically filled with the type. The status can be of the following types:
Open, Interim Approval (optional), Approval (optional), or Completed. The status that you choose
here's what defines the status to which the user is allowed to move the quality object.

iii. Select a Next Status from the menu.

Note:  Make sure you don't use the previous status as the autopromotion status for the last
workflow status. This can create a loop and result in stuck workflows.

iv. In the Allow Updates column, selecting the check box indicates that you can update the issue or
action while it's in this status.

Note:  The Allow Updates setting controls the user's ability to update the issue or action in
a particular status within the workflow. You can enable or disable this setting for each status
separately. For example, you could allow updates for Open, Interim Approval, and Approval
statuses, but disallow updates for Scheduled and Completed statuses.

v. Promotion or Demotion: Set the Promotion or Demotion status that an object will automatically
go to once it's Approved or Rejected by the Approver or Approvers.

c. Select the Approval type row of the Workflow Status Sequence and it displays the following fields in the
Status Details panel.

i. In the Response Required From column, select an option: One or All, indicating that a response is
required from either one or all the assigned approvers to complete the process of approval.

ii. Click the icon in the Assigned To column to assign a user as an approver.
iii. In the Assigned to dialog box, click Add (+) to add one or more users.
iv. Click the Search button. In the Select and Add: Assigned To dialog box that appears enter a name

and search for it. Select the name from the search result and click OK.
3. Navigate to the Quality Management work area to search for the workflow template that was created for a

quality issue.

a. Click the Create (+) menu and select the Quality Issue option.
b. In the Create Quality Issue dialog box, click the Workflow menu and notice that the Executive Approval

Workflow (that you created) appears as an option.
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Related Topics
• Watch Video: Create a Quality Management Workflow

Considerations for Configuring Quality Workflows  
To ensure that the workflow of a quality action or issue doesn't get stuck, you must keep these considerations in mind
while configuring a quality workflow.

• The Next status must never be blank in the workflow. Add at least one status from succeeding statuses of the
workflow to ensure that the quality action or issue can move to the next workflow.

• Closed or Completed status must be added to any workflow to ensure the quality action or issue can be closed.

• Ensure that the Closed or Completed status is always the last status in a workflow and that the second last
status in the sequence of the workflow always has an option to move to the Closed or Completed status.

Configure Approvals  

Overview of Workflow and Approval Management  
The BPM Worklist enables you to configure quality issues and actions through a set of workflows. Here's a summary of
the configuration tasks:

1. Run the Manage Task Configurations for Supply Chain Management task in the Product Management offering.
This provides access to BPM Worklist.

2. Update the workflow tasks by including details of deadlines and escalation policy.
3. Select the notification type and provide additional details to configure the notification.
4. Create approval groups that include a predefined set of users configured to act on the notification.

Note:  The user-defined approval task lets you add users or user groups as approvers, without specifying any
conditions, when configuring the workflow.

5. Create approval rules that include conditions for approval.

Configure Approval Tasks Using BPM Worklist
As an administrator, you can review and modify the approval tasks defined by a workflow designer.

To configure approval tasks in quality actions and issues:

1. In the Setup and Maintenance work area go to the following:

◦ Offering: Product Management

◦ Functional Area: Change Orders

◦ Task: Manage Task Configurations for Supply Chain Management

Alternatively, you can also arrive at the BPM Worklist page by the following method:

67

https://videohub.oracle.com/media/Create+a+Quality+Management+Workflow/0_fqavsl1u


Oracle Fusion Cloud SCM
Using Quality Management

Chapter 7
Set Up Quality Issues and Quality Actions

◦ Navigate to Bell Notification and click More Details.

◦ In the upcoming BPM Worklist page, select Administration from the drop-down list.

2. On the BPM Worklist page, click the Task Configuration tab.
3. In the Tasks to be configured panel, select the approval task. For example: Select

WorkflowStatusUserDefinedApprovalTask for quality objects.
4. Click the Edit Task icon in the side panel.

Here are the configuration options that appear on the side tabs of the Configuration page:

• General: Define basic information such as title, description, and priority. Selecting Hide task creator prevents
the display of task creator's name in the approval notification.

• Assignees: Create an approval rule. For example, to control the approval of all quality issues created by a user,
you can route them to a particular approval group.

• Data: Review the message elements that compose the structure of the task payload. Don't edit this information.

• Deadlines: Specify the duration and expiration details.

◦ Due Date: Indicates the date when the approval task is due for action. It is an indicator to remind the
approver to respond by a certain time. The approver can also respond after the due date.

◦ Expiration Settings: Specify the expiration policy at either task or assignee level, or skip it entirely.

◦ Exclude Saturday and Sunday: Excludes Saturday and Sunday while computing the due date, expiration
date, and escalation date.

• Notifications: Notifications inform participants about the occurrence of different events and enable them to
take actions.

• Access: Configure the signature (or password) policy for the task. When the quality issue reaches the Approval
status, users are prompted to enter their login credentials.

• Configuration: Configure whether users must enter comments when they approve or reject a task.

◦ Required: Comments are mandatory for the user.

◦ Optional: Comments are optional for the user.

◦ Not Allowed: Comments aren't allowed for the user.

Overview of BPM Workflow Notifications  
As the business object progresses through the workflow, several notifications are sent out. Notifications inform
participants about the occurrence of different events and enable them take actions.

Individual notifications are sent for each row in the definition workflow steps.

If an assignee is present for multiple associations across items for a single step, then:

• The assignee receives notification for each task.

• Each task can be delegated as required.

• After the step sequence is completed, notification for the next step is sent.

If the business object fails in a scheduled state, a consolidated notification is sent for all the failed lines.
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The following notifications are sent: a detailed notification, and a task entry worklist table. The detailed notification
displays the basic header attributes and assigned items. In an approval notification, an approver can enter comments
and add attachments. The task entry notification is a one line entry in the worklist table of the item work area; you can't
open it in a separate window.

Configure Workflow Notifications  
The approval notification informs the respective approver to review the business transaction and take action.
Notifications can be sent through email, or application bell notification.

Here are the notification modes:

• All: Both email and bell notifications

• None: Neither email nor bell notifications

• Email: Only email and no bell notifications

• In-app: Only bell notifications.

Notifications indicate that a user or group is assigned with a task, or the task status has changed. Notifications are sent
to different types of participants for different actions.

Managing email notifications includes the following:

• Enable the notification: Click the plus icon to add new notification entry, choose the task status, and notification
recipient.

• Disable the notification: Select the appropriate action and click delete to disable the notification.

Users can also allow actions on notifications and enable attachments to be sent with notifications. Allowing actions
enables recipients to approve or reject an object. If an attachment is present, users can send the attachment through
email for review.

Notification Header

Users can add the company logo or company name in the notification header. The default value of notification headers
is null.

Any new notification added by the user includes the following header value:

 "concat(string('Task '), /task:task/task:title, string(' requires your attention.')"

It's recommended to change the header value to null.

To change the company logo, include your company URL and provide a proper alternative text.

For example, img src="http://b-i.forbesimg.com/joshbersin/files/2013/07/company-logo3.jpg" width="230"

height="69" alt='Company Logo'

Bell Notification Sync-up

The Synchronize Bell Notifications ESS job is used to sync the Bell Notification dialog box with online BPM notifications.
All the completed notifications are removed from Bell Notifications.

The FND_MANAGE_SCHEDULED_JOB_DEFINITION_PRIV privilege, is required to schedule or execute the Synchronize
Bell Notifications ESS job.

Managing Bell Notifications
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Enable/Disable Bell Notification: Uses the settings configured for email notifications. If the email notification is disabled
for specific action, the user doesn't receive bell or email notification.

Enable Reminder: Send task reminders based on the time when the task was assigned to a user or the time of task
expiration. The number of reminders and the interval between the reminders can also be configured.

More Options: Here are the additional options (on the Notifications tab of the BPM Worklist) to configure email
notification.

• Make notification secure (exclude details): Prevents any business transaction details from appearing in email
notifications.

• Do not send multiple notifications for the same task.

• Hide End User Web URL in notifications: Removes the link that provides access to the task in Workspace
Application instead of the underlying transaction.

• Make notification actionable: Controls the following links in notification email: Approve, Reject, and Request
More Information.

• Send task attachments with email notifications: Allows supporting documents to be attached to email
notification.

Note:  For details of all notifications in Product Management, see View Product Management Notifications on the
Oracle Help Center.

Related Topics
• View Product Management Notifications

Actions for Reviewers and Approvers  
Users added as approvers for a change status can perform several actions, while users added as reviewers are simply
informed about the change through FYI notifications.

As a reviewer, you can review notifications from:

• Bell icon

• BPM Worklist

• Email

As an approver, you can perform the following actions:

• Approve

• Reject: You can reject the task to prevent further approval.

• Request More Information: If the task assignee wants more clarification from the requester, the task can again
be sent to the requester. Users can also specify who requested the information. The task isn't rejected and once
the required information is provided, the approval flow begins again.

• Reassign: You can assign the task to another user for approval. The new user's hierarchy is used for approval.
For example, if a user thinks that the task is relevant to another department, he can reassign it.

• Delegate: You can delegate the task to another user. After approval by the delegate, the initial user's hierarchy
is used for approval. The delegate can still act on the task after task expiry.

• Withdraw: If you're the task initiator, you can withdraw the task after the approval has been initiated.
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• Escalate: You can escalate the task from the current assignee to the supervisor.

• Claim: A task that's assigned to a role or multiple users must first be claimed. Claim is available for group or
multi-user assignments. After you claim the task, all applicable actions are listed. Claim is available only if auto
claim is disabled and the response required from is set to One.

• Dismiss: Used for a task that requires the person (acting on the task) to acknowledge the receipt. This is similar
to an FYI notification, which doesn't involve any action.

• Resume: A task that was halted by a Suspend action can be worked on again.

• Release Claim: Release a claimed task so that it can be claimed by other assignees.

• Suspend: The expiration date remains suspended until the task is resumed. After suspension, options to
update a task are disabled.

Note:

◦ The Suspend and Resume tasks are only available for users with the BPMWorkflowSuspend
privilege.

◦ Dismiss is the only action supported for FYI notifications.

Related Topics
• Create an Approval Rule

Configure Approval and Rejection Comments  
You can configure approval and rejection comments as per your business requirements for quality issues and actions in
the BPM work area. Comments for approval or rejection are required or optional as set in the BPM console.

You can manage approval comments by defining if they're Required, Optional, or Not Allowed during approval or
rejection of a quality object workflow. Alignment with the BPM worklist improves usability and ensures that you comply
with regulatory guidelines about commenting during approval and rejection.

1. Navigate to the Task Configuration tab in the BPM Worklist (Bell Icon > Show All > Worklist > [user name] >
Administration > Task Configuration).

2. In the Tasks to be configured panel, search for and click WorkflowStatusUserDefinedApprovalTask, which
applies to both, issue and actions.

3. Click the Edit task icon.
4. Click the Configuration side tab.
5. Select commenting options for the Approve and Reject actions:

◦ Required: If set to Required, providing comments for approval or rejection is compulsory.

◦ Optional: If set to Optional, then providing comments for approval or rejection isn't compulsory.

◦ Not Allowed: If set to Not Allowed, no comments are allowed, and approval and rejection is immediate.

6. Click Save and Commit to save the changes.
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Configure Password Policy for Approvals  
You can set up a password policy to authenticate the approval process for quality issues and actions. This ensures that
approvers are prompted to enter their sign in credentials before they approve the quality issue or action.

The credentials are also used to audit the approval process.

1. In the Setup and Maintenance work area, select the Product Management offering.
2. Run the Manage Task Configurations for Supply Chain Management task.
3. Select WorkflowStatusUserDefinedApprovalTask.
4. Click the Edit task icon.
5. Click Access.
6. Select one of the following applicable policies to authenticate the approval process from the Signature Policy

drop-down list:

◦ No Signature Required - the default value

◦ Password Required - enter sign in user name and password

◦ Digital Certificate Required - use a digital certificate (or e-signature)

Note:  If the quality issue or action is already in the Approval status when the password policy is enabled,
the user doesn't receive the authentication prompt. If the quality issue or action is in the Open status and
the password policy is enabled, the user receives the authentication prompt when the quality issue or action
reaches the Approval status.

FAQs on Configuring Quality Objects  

How can I change the status of a workflow to a prior state without
rejecting or restarting?  
In BPM, the initiator of the quality object can withdraw tasks which are pending approval.

Navigate to Bell notification > More Details. Click Initiated Tasks. Select the quality issue or action which was sent
for approval. Select the Withdraw option from the Actions menu. Then, restart the workflow by changing the status to
Open.

How can I prevent unsaved changes from disappearing when I
switch between tabs?  
Use Page Composer to configure field settings so that edits are automatically saved.
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To do this, edit the task flow using Page Composer. In a sandbox that includes the Page Composer tool, open the page
where the field appears. Click Tools > Page Composer to enable the Page Composer view, and then click the Structure
tab. Select the field component, open its properties panel and select the Auto Submit checkbox.

How do I manage organizations in Quality Management Cloud?  
Using the Manage Inventory Organizations setup task, you can create and maintain organizations.

Ensure access to listed organizations when creating a quality issue or action. Run the Manage Data Access for Users
task in the Setup and Maintenance work area. Based on their job roles, users are assigned access to specific security
contexts that affect their visibility of data.

Only items that are associated to an inventory organization can be added as affected items on a quality issue or action.
Quality issues and actions are created against available, manufactured, or received items. Inventory balances aren't
maintained for item organizations, so such organizations aren't valid for quality issues and actions. Item organizations
are used to define items for which inventory balances aren't stored, inventory storage or inventory movement isn't
reflected, and no financial transactions occur in the downstream applications.

Note:  Item organizations are valid for problem reports and corrective actions that are based on change types.

Related Topics
• How can I change an item organization to an inventory organization?

How can I restrict users from making updates to issues or actions
in a specific status ?  
Using the Manage Workflow Templates for Product Lifecycle Management task in the Setup and Maintenance work area
you can disable the Allow Updates option for that specific status.
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8  Problem Reports and Corrective Actions

Overview of Problem Reports and Corrective Actions  
The Product Information Management and Product Development work areas integrate with the Quality Management
module to help you gain insight to problem reports and corrective actions related to items.

• A problem report is a generic quality incident or problem reported from a customer's perspective.

• A corrective action is an action that you take to address or prevent the problem from occurring again.

You can create problem reports and corrective actions for an item from Product Information Management, Product
Development and Quality Management work areas, and from Supplier Portal.

• On opening an item in the Product Development work area, the Quality tab displays a blue icon, if the item has
quality-related data. And on hovering over the Quality tab, the tool tip displays Quality: Has Content.

• The Quality tab displays both these tabs:

◦ Quality Issues and Quality Actions

◦ Problem Reports and Corrective Actions

To use advanced workflow capabilities such as additional controls and group approvals, create and manage problem
reports and corrective actions just as you would change types in Product Development.

This is particularly recommended for engineering design use cases where you capture issues related to items. You then
collaborate with suppliers through workflow steps for proper resolution.

These types of problem reports and corrective actions are structured more like change requests. They provide tabs
for General Information, Affected Objects, Tasks, Attachments, Workflow, Impact Analysis, Relationships, Security, and
History.

By configuring the workflow steps, you can:

• Specify automatic status promotion or demotion

• Define entry and exit criteria

• Control who can perform what action

• Perform impact analysis

• Create and assign tasks to track dependencies.

Create Problem Reports and Corrective Actions  
You can create problem reports and corrective actions from the:

• Create (+) menu on the Overview page in the Quality management work area

• Actions menu of an item in the Product Development work area
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• Actions menu of an item in the Product Information Management work area

You can see that they appear on the Quality tab of items in the Product Development, Product Information
Management, and Quality Management work areas. Remember that the Create Problem Report and Create Corrective
Action options appear on the Actions menu only after you create and save an item.

For suppliers the page reloads with the newly created object.

Note:  The newly created problem reports and corrective actions automatically display organization data from the
item.

The workflow of a problem report or corrective action progresses as specified by the statuses defined by the
administrator. For more details, see Set Up Problem Reports and Corrective Actions.

Create 8D Corrective Action.

You can choose to create a corrective action from the following two options in the Type drop-down list:

• Corrective Action – action to mitigate a quality issue and prevent its further occurrence.

• 8D Corrective Actions – action that uses the 8D methodology. An investigative dive to find the cause of a
problem, a solution to fix it and a method to prevent recurrence.

The 8D methodology involves a systematic investigation into the root cause of a problem to prevent recurrence. It uses
a structured, preconfigured template based on 8 disciplines to define the problem, identify the root cause, and run the
corrective and preventative action (CAPA) to prevent recurrence.

Here’s a brief description of the eight disciplines:

1. Plan and form team: Create a plan to minimize or mitigate the problem and establish a team of skillful and
knowledgeable people

2. Define Problem: define and describe the problem
3. Interim Containment: define and implement containment actions
4. Determine Root Cause: identify the root cause
5. Verify Correction: verify and choose the most effective corrective action
6. Implement Corrective Actions: implement the corrective actions
7. Prevent Recurrence: implement actions to prevent a recurrence
8. Recognize Team Effort: acknowledge and congratulate the collective effort of the team.

Note:  Although the change type 8D Corrective Actions is predefined, the attribute visibility setting is read-only. The
change type inherits the configuration from its parent change type, Corrective Action.

Create a Corrective Action from a Problem Report

You can also create a corrective action from the Actions menu of a problem report. The corrective action opens in a
dynamic tab for editing. For suppliers the page reloads with the newly created object.

While creating a corrective action from a problem report, you can select to copy over the descriptive flexfields,
attachments, relationships, and tasks for the problem report. You can also copy over the affected objects including
descriptive flexfields to the new corrective action. The corrective action is automatically linked to the problem report in
the Relationships tab.
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Related Topics
• Overview of Change Type Setup

• Configure Change Orders

• Understand Change Types

Autocreate Problem Reports When Inspections Fail  
When a nonconformance inspection failure occurs a problem report is created automatically from the inspection and
associated with the inspection and other related objects.

Additionally, you can manually create new problem reports with the predefined problem report types.

Remember to set the profile option value for 'ORA_ ENQ_INSP_CREATE _PR' to Yes to enable the option to create a
problem report when there’s a failure in inspection.

The following relationships on the problem reports and corrective actions are supported:

• Inspection

• Resource

• Asset

• Receipt

• Work order operation

• Work center

When there's a problem report created automatically from the inspection, the related relationship object is added to the
Relationships tab on the problem report.

The following nonconformance problem report types are supported:

• Nonconformance - Inventory

• Nonconformance - Resource

• Nonconformance - Receiving

• Nonconformance - Work in Process

• Nonconformance - Assets

Problem Report Type Object Relationships

Nonconformance - Inventory
 

Inspection
 

Nonconformance - Resource
 

Work center, Resource, and Inspection
 

Nonconformance - Receiving
 

Receipt and Inspection
 

Nonconformance - Work in Process Work order operation and Inspection
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Problem Report Type Object Relationships

  

Nonconformance - Assets Inspection and Assets

Note:
• The newly supported relationship objects are associated with the problem report automatically when there's a

problem report created from the inspection, depending on the nonconformance. You can't search for them and
add them directly from the Relationships tab.

• The option to create dependencies on the related objects for the new relationship objects isn't supported.

Related Topics
• Set Up for Problem Report Creation When Inspection Fails

Use Problem Reports and Corrective Actions for
Engineering Design  
Your administrator can set up problem reports and corrective actions to use advanced workflows, just like engineering
change requests.

Once set up this way, you can create these problem reports and corrective actions directly from the Create menu -
Create > Problem Report or Create > Corrective action. The look and behaviour of these objects are quite different from
regular quality issues and actions.

You can also use the Search > Problem Reports or Search > Corrective Actions menu to find predefined problem
report and corrective action objects and then edit or duplicate them to create your own. To quickly find an object,
remember to mark it as a favorite when you create it. You can then use the Favorites infolet or the Favorites menu to
find it.

Here's a comparison between problem reports and corrective actions created this way and regular quality issues and
actions, to help you understand what functionality is available and what's not for each type of object.

Tabs/Pages Problem Report Corrective Action Quality Issue Quality Action

General Information
 

Yes
 

Yes
 

Yes
 

Yes
 

Affected Objects
 

Yes
 

Yes
 

Yes
 

Yes
 

Tasks
 

Yes
 

Yes
 

No
 

No
 

Attachments
 

Yes
 

Yes
 

Yes
 

Yes
 

Workflow Yes Yes Yes Yes
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Tabs/Pages Problem Report Corrective Action Quality Issue Quality Action

     

Impact Analysis
 

Yes
 

Yes
 

No
 

No
 

Relationships
 

Yes
 

Yes
 

Yes
 

Yes
 

Security
 

Yes
 

Yes
 

Yes
 

Yes
 

History
 

Yes
 

Yes
 

Audit
 

Audit
 

Similar Issues
 

No
 

No
 

Yes
 

No
 

This table lists the functionality available for each type of object.

Functionality Problem Report/Corrective Action as Change
Type

Quality Issue/ Quality Action

Create from an item
 

Yes
 

Yes
 

Set Relationship rule
 

Yes
 

Yes
 

View on item Quality tab
 

Yes
 

Yes
 

Identify using Has Issue icon on a structure
 

Yes
 

Yes
 

Entry/Exit Required Fields
 

Yes
 

No
 

Related Topics
• Overview of Change Orders and Change Requests

Manage Problem Reports and Corrective Actions  
You can search for problem reports and corrective actions and also use filters to narrow your search results to the most
relevant results.

You can also use the Add Fields option to add additional fields to the search criteria. The fields you add appear as
columns in the search results table.
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Here are some details on the Manage Problem Reports and Corrective Actions pages:

• Search Filter

You can use this filter to search by a change type. The default search filter is set to All Change Types.

• Saved Search

The default saved search is titled Application Default. This is executed when you select a change type.

• Manage Watchlist

Use the Watchlist to track important business objects. The watchlist is categorized by the functional areas.
Each item on the Watchlist page is made up of descriptive text followed by a count. Click the watchlist item to
navigate to the object of interest.

You can create your own watchlist items based on saved searches. Click the Manage Watchlist icon on the
Manage Change Orders or Manage Change Request page. In the Manage Watchlist dialog box, select the check
box Include Saved Searches to add the saved searches to the watchlist.

You can use the Watchlist page in the Set Preferences work area (Navigator > Tools > Set Preferences) to
determine which categories and items to show or hide in the watchlist.

You can create watchlists for corrective actions and problem reports.

Search for Workflows, Approvals, and History  
You can use the Product Management Search interface to configure and run a search for workflows, workflow approvals
and workflow history.

To navigate to the search page, go to Tasks > Product Management Experience > Search Products. On the Product
Management Search page, you can select one of the following:

• Workflow

• Workflow Approvals

• Workflow History

Search for Workflow
Workflow search can be used to configure and run a search for change orders, change requests, problem reports, and
corrective actions. You can combine multiple keyword searches along with applied filters to complete the search. For
example, you can search for:

• all changes created within a date range.

• all high priority changes in open status assigned to you.

• all changes based on Customer, Supplier, Manufacturer, and Source information.

• data presence indicators for tasks, attachments, and relationships.

• all changes of type New Product Introduction (NPI), and change extensible flexfields of product lines.

80



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 8
Problem Reports and Corrective Actions

Search for Workflow Approvals
You can search for workflow approvals that need your attention by searching for both users and roles with participant
types of Approver, Optional Approver, or Reviewer. This is supported for change orders, change requests, problem
reports, and corrective actions in open, interim approval and approval workflow status types.

When you've a role as a participant and Response Required From is One, use this combination of filter chips to aid
your search:
If the approval task hasn't been claimed by any member of the role:

Participants Participant Role Activity Type

Role Name Role Name Approval

If the approval task has been claimed by one member of the role:

Participants Participant Role Activity Type

User (person who has claimed it) Role Name Approval

Here are the example use cases for Workflow Approvals search by user role:

• Change and Quality Analyst:

◦ Workflows pending approvals from a user or roles

◦ High priority workflows pending approval

◦ Overdue pending approvals

• Approver or Reviewer:

◦ My pending approvals

◦ Workflows that need my review

• Manager:

◦ Workflows pending approvals from my group

◦ High priority workflows pending approval from my group

◦ Overdue pending approvals from my group

Search for Workflow History
You can search across change types to find all affected object redlines and updates made to the change header,
workflow status, and other workflow entities.

For example:

• To find all workflow edits made by a specific user, Riley Smith, between June 23, 2024, and July 2, 2024, you can
filter the search results based on workflow type, author, and date.

• To find all workflow history for a specific affected object, enter the affected object name in the search box.
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Tips for Search
When you search for workflows, workflow approvals, or workflow history, you can:

• Select any configured view.

• Based on the configuration of the selected view, you can:

◦ search by keywords.

◦ apply one or more filters on the search results.

• Show or hide columns in the search results.

• Use the Sort function to select one or more columns to sort by. You can sort by multiple columns.

• Export the selected list of workflows, workflow approvals, or workflow history.

• You can apply filters or remove filters from filter drawer.

The Workflow Type (on the Product Management Search page) will be filtered to certain change types depending on the
work area from where you launch the search; however, you can override the filter to display all change types.

Work Area Change Types Filtered To

Product Development Engineering change order, Change orders without revision control, Engineering change request,
 Design change request

Product Information Management Commercialization change order

Quality Management Problem report, Corrective and preventive action

Note:
• When you select the object, it will be opened in its respective work area, regardless of the work area from which

you've launched the search.

• You can search for multiple changes by entering change numbers separated by space. For example: NPI123
ECO124 ECR156.

Product Lifecycle Management Navigator  
You can use the Product Lifecycle Management Navigator to access your saved searches across Product Lifecycle
Management objects and add, pin, and copy items to and from your clipboard.

You can also navigate to a specific tab of an item from the clipboard. Access the Product Lifecycle Management
Navigator from the classic UI by selecting Product Management Experience > Search Products. You can pin the
Navigator so that it persists in the left-hand panel. To dismiss the Navigator you unpin and click in the right-hand panel;
click the Navigator tab to access it again.

Access Saved Searches

In the Navigator's Saved Searches tab, you can:

• Easily find and select personal saved searches across objects

82



Oracle Fusion Cloud SCM
Using Quality Management

Chapter 8
Problem Reports and Corrective Actions

• Run saved searches in the panel on the right-hand side

• Use the search to search for saved searches by name

• Use the filters to limit searching by:

◦ Object

◦ Saved Searches (currently only personal Saved Searches are supported).

Note: Only personal saved searches are available for selection in the Product Lifecycle Management Navigator Saved
Searches tab.

Access Clipboard

With the Product Lifecycle Management Navigator Clipboard tab, you can:

• Add items you wish to use elsewhere in the classic UI. You can select the item, click the copy icon, and navigate
to the classic UI and paste these selected items onto the structure or change affected objects tabs.

• Pin clipboard items so that they appear at the top (beginning) of the clipboard for quicker access.

• Click the ellipses (...) button to select which item tab to load in the right-hand panel.

• Use the filters to limit searching clipboard items by:

◦ Pinned or not pinned items

◦ Object

Note:
• Only items can be added to the clipboard.

• Pinned items are displayed at the top (beginning) of the clipboard and have their checkboxes selected, followed
by items most recently copied to the clipboard.

Related Topics
• Search Region

Edit Problem Reports and Corrective Actions  
Problem reports and corrective actions that you create directly using the Create > Problem Report or Create > Corrective
Action menus are configured to use advanced workflows.

These objects appear without infotiles, but with more side tabs. You can use them to view and edit object details.
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Note:
• Content presence indicators: Blue side tabs on problem reports and corrective actions indicate the presence

of content in the tabs. The blue tab icons appear on the following tabs - Affected Objects, Tasks, Attachments,
Security, and Relationships. The blue icons don't appear for those tabs that always have content, or have
content calculated upon selecting the following tabs: General Information, Workflow, History, and Impact
Analysis.

• Create new objects based on existing ones: You can use the Save As action on existing problem reports and
corrective actions to create new problem reports and corrective actions. Enter the details of the new object in
the Create dialog box.

You can choose to copy over the existing descriptive flexfields, attachments, relationships, tasks, extensible
flexfields, contextual attributes, and affected objects.

To copy over extensible flexfields select the Additional Information option.

• General Information: View basic information about the problem report or corrective action. Some fields appear
with a contextual information icon that you can click to open an information panel with more details.

The panel displays the following details:

◦ For customers - Account Description, Account Number, Registry ID, D-U-N-S Number, Country, and
Address.

◦ For suppliers - Alternate Name, Supplier Number, and D-U-N-S Number.

These additional parameters also help you search for customers and suppliers.

• Affected Objects: View objects affected by the proposed problem report or corrective action.

Fill in Attributes:

◦ To quickly replicate attributes in the Affected Objects tables on change orders, change requests, problem
reports, and corrective actions, use the following actions:

- Fill Up (Ctrl+U)
- Fill Down (Ctrl+D)
- Fill Selected (Ctrl+S)

◦ To populate similar changes in a consecutive range of rows, use actions Fill Up (Ctrl+U), and Fill Down
(Ctrl+D). Remember that you’ve to select the table cell and change the value in the cell for Fill Up and Fill
Down to work.

◦ To populate changes in nonconsecutive rows, use the action Fill Selected (Ctrl+S).

• Tasks: Create a checklist of tasks related to the problem report or corrective action.

• Attachments: Add text or graphic files, or URLs, with more information about the problem report or corrective
action; classify attachments into categories.

• Workflow: View the sequence of statuses through which the problem report or corrective action advances as
the workflow progresses.
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• Impact Analysis: View how the problem report or corrective action impacts other objects.

• Relationships: Create associations between the problem report or corrective action and any other business
objects.

• Security: Define who should have access to the object. You can search and select by Person (user name) or by
Role. For more information, see Secure Access to Changes.

• History: View a record of the sequence of actions on the object.

Related Topics
• Manage Tasks in Problem Reports and Corrective Actions

• Create Problem Reports and Corrective Actions

• Impact Analysis in Change Orders

• Overview of Additional Workflow Controls

Relate Problem Reports and Corrective Actions  
You can relate problem reports and corrective actions to other objects - this helps in identifying and performing
required actions to resolve product issues.

Grouping similar problem reports helps you to identify patterns in problem reports and take corrective actions.

You can relate problem reports and corrective actions to:

• Other problem reports and corrective actions

• Product Development objects

• Innovation Management objects

• Quality Management objects.

Related Topics
• Set Up for Problem Report Creation When Inspection Fails

Relationship Rules for Changes, Problem Reports, and
Corrective Actions  
You can create relationship rules between change orders, change requests, problem reports, and corrective actions.

Use these rules to change the status of one object when the status of a related object is changed to a specific value.
For example, you can create a rule to close a corrective action when a related change order is implemented. Here the
'source' object on which the rule is defined is the change order, and the 'target' object that the rule should act upon is
the related corrective action.

You create relationship rules using the Add Rule button on the Relationships tab of the source object. Before you create
a rule, the target object must be added as a related object on this tab.
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When you add a rule, it lists the source object and then the target object.

Rule Syntax: When <source object name> moves to <status name> status, Move <target object name> to <status
name> status.

Rule example: When ECO 567657 moves to Completed status, move corrective action Keyboard Malfunction to Closed
status.

When the rule is triggered and the target object moves to the specified status, you'll see the action recorded in the
History tab of the target object.

Considerations:

• A relationship can only have one rule. However, this feature supports one-to-one, one-to-many, and many-to-
many relationship rules between the source and target objects.

• You can add or delete rules on both the source and target objects as required.

Note:  Users with permissions for the Manage Relationships action in Additional Workflow Controls set to Yes can
add relationship rules.

On the Relationships tab of a change object:

• Click the + icon to create a rule.

• Click the pencil icon to edit the relationship rule.

• Click the X icon to delete the rule.

The rule doesn’t trigger if the target object:

• hasn't reached the status just before the status specified in the rule.

• is canceled.

Here are some points you must remember while choosing the target and source objects and setting rules:

• The source object status can be in any status type except Scheduled.

• The target object status can be in any status type except Scheduled or Completed.

• If a rule fails, you can manually move the target object forward.

• Approval steps won't be skipped.

• The target object moves to the specified status even if you don't have access to edit the target object.

Manage Tasks in Problem Reports and Corrective
Actions  
You can create a checklist of tasks related to the problem report or corrective action and assign work to individuals.

You can make it compulsory for certain tasks to be completed by specified users before the problem report or corrective
can progress to a status.
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Here are some more details on tasks:

• Your ability to manage tasks depends on the permissions for the Manage Tasks action in Additional Workflow
Controls for the change type.

• You can mark the status of a task and assign tasks even after the problem report is complete. Use this to
manage tasks after completion, such as documenting any recommendation. Note that only the assignee can
manage tasks in Completed status.

• The task can't be set as required if the Complete Before Status is one of the following: Blank, First Open
Status, Scheduled, or Completed.

Note:  Status First Open indicates the first open status in case your administrator has configured more open
statuses.

Task Examples - Problem Report:

• Review customer complaint

• Create detailed report

• Get feedback from Engineering

• Link similar issues

Task Examples - Corrective Action:

• Review similar issues

• Identify root cause

• Inform suppliers

• Document solution

The Tasks table includes the following fields that let you specify task details:

• Sequence: Decides the order in which the tasks are performed. By default, this increments by 10.

• Required: Indicates that the task is compulsory for the problem report to progress. If a task is compulsory, then
a Complete-Before Status must be specified.

• Assigned To: Specifies the person to whom the task is assigned.

• Assigned By: Specifies the user who assigned the task.

• Assigned On: The date and time when the task was assigned.
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Note:  If the same task has been assigned by different users, the Assigned By and Assigned On fields show details of
the latest assignment.

• Start-by Status: The status at which the tasks should be started. Includes current and future statuses, and a
blank value. Use the blank value when you want the task to being irrespective of the status.

• Complete-Before Status: The status before which the task should be completed. Includes future statuses and
a blank value. Use the blank value to leave this field blank when Start-by Status is set to Completed.

• Need by-Date: Indicates the date on which the tasks should be completed.

• Task Status: Can be updated only by the task assignee or the change analyst.

Create Tasks for Problem Reports or Corrective Actions
To create a task for either a problem report or a corrective action, click the Tasks side tab. Select Add from the Actions
menu or click the + icon to add lines to the Tasks table when you define or edit a problem report or corrective action.
To mark a task complete, or to cancel a task, change the status in the Task Status column. You can modify an existing
problem report or corrective action task if its task status is Open.

Copy Existing Tasks to New Problem Reports or Corrective Actions
You can create a new problem report or corrective action based on an existing one and copy over the tasks. Use the
Save As action (in the problem report or corrective action). Tasks in the newly created problem report or corrective
action are reset to the Open state.

Modify Assignee  
If your workflow is stuck due to absence of the assignee, you can modify both assignee role and default assignee.

You can modify these fields on the following objects: change orders, change requests, problem reports, and corrective
actions if they're stuck.

Before you modify the assignee role or the assignee, here's what you need to know:

• It's recommended that you always populate the Assignee Role field on the General Information tab so that the
Assigned To user can add approvers during the approval workflow.

• The Assignee Role field can be edited in the Draft and Open statuses. If the object is in interim or approval
status, you must terminate the workflow.

• To modify the Assignee Role and Assigned To fields, you must have the Manage Assignee privilege. You must
also have permission to manage change header attributes as defined in the Additional Workflow Controls table
in change type setup.

• If the assignee role isn't defined, the new assignee must have the BPMWorkflowAdmin privilege to terminate
the workflow and reassign.
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• If the assignee role isn't defined and the new assignee wants to reassign or delegate a task from BPM
Worklist, the new assignee must have the BPMWorkflowSCMAdmin privilege to view all the approval tasks in
Administrative Tasks.

• You can't edit the Assignee Role or Assigned To fields for objects that were added prior to the support of
Additional Controls in update 20B.

• Only the Assigned To user can see the Terminate and Restart actions in the Actions menu. Ensure that a user
name is provided in the Assigned To field.

Note:  If you have modified the assignee's user name during a change order or new item request workflow, an error
message appears. To resolve the error, terminate and restart the workflow.

Related Topics
• Configure Default Assignee for Quality Issues and Actions

Add or Remove Participants from Future Status  
You can add or remove participants from a future status in the workflow when the change is in draft, open, interim
approval, approval, or scheduled status. Note that this depends on the permissions assigned in the additional workflow
controls table.

Your participants include reviewers, approvers, and optional approvers.

To add participants to a future status, you must select the future status in the workflow and click Add in the Participants
section.

Note:
• Your participants receive notifications which can be configured by your administrator.

• A Claim button appears on the approval notification when multiple reviewers are added. If one of the reviewers
claims the task, the others don't see any action buttons on the notification.

Current Change Status For Future Approval Status For Future Scheduled Status For Future Completed Status

Open Add or remove users and roles
such as approvers, optional
approvers, and reviewers.
 

Add or remove users and roles
such as reviewers.
 

Add or remove users and roles
such as reviewers.
 

Approval N/A Add users and roles such as
reviewers.

Add users and roles such as
reviewers.

Related Topics
• Actions You Can Control
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Add or Remove Participants in Current Status  
You can add or remove approvers in the interim approval and approval status. You can add or remove participants of
type reviewers when the change is in draft, open, approval, and interim approval, scheduled, or completed statuses.

You can add roles as approvers or reviewers while approvals are in progress.

Note:
• Participants include reviewers, approvers, and optional approvers.

• This is applicable for change orders, change requests, problem reports, and corrective actions.

• Adding participants depends on the permissions assigned in the additional workflow controls table.

Here are some additional details:

• The newly added participants receive notifications. You’re restricted from adding a role that has more than 40
members to the approval workflow if the Response Required From field is set to All. This happens when you
promote the change. Also, automatic promotion is prevented. You’ll see a new entry in the action log and a
notification is sent to the analyst.

• Optional approvers can't be added when approval is in progress.

• Only the change analyst can remove approvers or reviewers in the current approval status.

• You can't add the same user as reviewer and approver.

• You can also remove a person or role from the participants list as long as there's at least one person or role
remaining as an approver. Only the change analyst can remove participants.

• You can't remove approvers who have already approved or rejected the change.

• You receive an FYI notification if you're removed as an approver or reviewer in the current interim approval or
approval status, and if you’re removed from the approval group.

◦ You can see the comments provided during the removal action in the notification.

Note:

◦ In BPM Worklist configuration, it’s recommended that you make commenting mandatory when
rejecting a change order so that rejection comments are captured.

◦ Comments are visible in the rejection notification for change orders, change requests, problem
reports, and corrective actions.

Related Topics
• Actions You Can Control

• View Product Management Notifications

• Why am I unable to add or remove approvers during the change order approval?
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How to Work with Suppliers to Manage Quality  
This example describes how Kevin, an engineer, and Adam, a supplier, work together to address a problem with the
RDO-1500 Mobile HF radio.

In this example, Kevin creates a specific type of problem report called Supplier Problem Report.

The administrator has added two configured text fields in this problem report type to capture responses – Supplier
Response and Engineering Response. He has also included a workflow status called Engineering Approval.

First, he ensures that Adam is added to the Security tab of the item and has the necessary privileges to view the item:
View Item Attributes, View item Basic, and View Item Pack, and View Item Structure.

The engineer creates a problem report

1. Kevin navigates to the Quality Management work area and creates a problem report.
2. In the Create Problem Report window, he chooses the type of problem report as Supplier Problem Report.
3. He adds the name and description, then saves the problem report:

◦ Name: RDO-1500 Power Issue

◦ Description: The RDO 1500 loses power 10 minutes after use.

4. On the Affected Objects tab, he adds the affected item.
5. On the Security Tab, he adds Adam as the supplier, so that he can access it.
6. He clicks Change Status to change the status of the problem report to Open and saves it again.

The supplier reviews the problem report and adds a response

1. Adam logs in to the Supplier Portal work area and accesses the problem report. He clicks on the Manage
Problem Reports task link.

2. On the Edit Supplier Problem Report page, he can see the details of the problem in the description field.
3. He clicks the Affected Objects tab and opens the item to check the structure. He realizes that the part has a

fault and needs to be replaced with a better part.
4. He provides his response in the Supplier Response field of the problem report. He adds details about replacing

the part and creating a corrective action: I see it’s using PS-2500 as the power supply. We’ve been having
trouble with that one. I’ll create a corrective action and propose a better part

5. He clicks Save.

The supplier creates a corrective action

1. From the Actions menu of the problem report, he clicks Create Corrective Action.
2. In the Create Corrective Action window, he chooses the type as Supplier Corrective Action. He enters a Name,

which, reflects the problem: Corrective action for RDO-1500 Power Issue and adds details in the Description
field, which suggests a solution: Try changing the power supply.

3. In the Supplier Response field, Adam recommends actions to be taken and adds the specification of the new
part as an attachment: PS-2500 failing tests. Recommend switching to PS-2510. Specification attached.

4. He then changes the status to Engineering Approval so that Kevin can review it for approval and saves it.

The engineer approves the corrective action

1. Kevin receives a notification from Adam about the corrective action. He reviews the specification for the new
part.
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2. Next, he navigates to the Relationships tab. The problem report is related to the new corrective action for
tracking purposes.

3. He also adds his own response in the Engineering Response field: Testing proved successful. Please proceed.

Now that Kevin has reviewed the specification, he can approve the corrective action.
4. He clicks Save and then clicks Approve.

Related Topics
• Watch Video: How to Work with Suppliers to Manage Quality
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9  Set Up Problem Reports and Corrective
Actions

Set Up Problem Reports and Corrective Actions As
Change Types  
Define problem reports and corrective actions as change types to use group approvals, additional workflow controls,
and other advanced functionality available for change types.

This setup is recommended if you're implementing Quality Management for engineering design and development
through Oracle Product Development Cloud. It's also required to enable supplier collaboration for issue identification
and resolution.

You set up problem reports and corrective actions using the Manage Change Order Types setup task, instead of using
the Manage Quality Issue or Actions Types task.

To set up problem reports and corrective actions as change types:

In the Setup and Maintenance work area, go to the following:

• Offering: Product Management

• Functional Area: Change Orders

• Task: Manage Change Order Types

Each type can be configured with additional workflow controls for workflow approval statuses, including status
promotion policy, entry and exit criteria, actions that are allowed by workflow participants and more.

To enable users to access this feature, you must assign the following roles to them:

• Quality Analyst Job Role (ORA_ENQ_QUALITY_ANALYST_JOB)

• Manage Problem Report (ACA_MANAGE_PROBLEM_REPORT_PRIV) OR Manage Corrective Action
(ACA_MANAGE_CORRECTIVE_ACTION_PRIV)

• Manage Item Change Order (EGO_MANAGE_ITEM_CHANGE_ORDER_PRIV)

• Data Security Policy: Access the item change for table EGO_ENGINEERING_CHANGES_B for the item changes
they've have access to.

You can also configure extensible flexfields for a change type so that these fields appear at the header level on problem
reports, and corrective actions. This feature is available only if you’ve opted in for the feature Use Extensible Flexfields
on Changes, Problem Reports and Corrective Actions. For more information, see the related topics.

Shown in the table here are the configuration options available to you when you create problem reports and corrective
actions as change types.

Feature Problem Reports and Corrective Actions as Change Types

Create from items
 

No
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Feature Problem Reports and Corrective Actions as Change Types

Set Relationship rules
 

Yes
 

View on item Quality tab
 

Yes
 

Identify with Has Issue icon on a structure
 

No
 

Apply granular controls to set allowed
actions for each status
 

Yes
 

Define who can create each object type
(Creators)
 

Yes
 

Configure workflow
 

Yes
 

Allow/Disallow object creation
 

No
 

Disable using End Date
 

Yes
 

The following table lists additional configuration options.

Configuration Problem Report/Corrective Action

Fields
 

Descriptive flexfields
 

Pages
 

Page Composer
 

Scripting
 

Application Composer
 

REST Service
 

product ChangeOrders
 

Related Topics
• Configure Context Specific Attributes for Change Types

• Relationship Rules for Changes, Problem Reports, and Corrective Actions

• Understand Change Types

• Configure Entry and Exit Criteria for Change Objects

• Overview of Additional Workflow Controls

• Configure Extensible Flexfields for Change Types

• Watch Video: Problem Report and Corrective Action Exit and Entry Criteria
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Set Up for Problem Report Creation When Inspection
Fails  
You can use the predefined problem report types to autocreate nonconformance problem report instead of quality
issues when inspections fail.

You can create problem reports of the predefined types in place of a quality issue, when nonconformity is reported
during the inspection process and a rule is configured to create a quality issue. A problem report is automatically
created when the rule is triggered from the inspection. The problem report is automatically associated with the
inspection and other related objects such as assets, inventory, resources, work-in-process products, and receipts.

Note:
• You must set the profile option value for 'ORA_ ENQ_INSP_CREATE _PR' to Yes to enable the option to create a

problem report in place of a quality issue when there’s a failure or nonconformance in inspection.

• The mapping of the priority for 'HIGH', 'MEDIUM' and 'LOW' lookup codes is already configured. If
there are any configured lookup values added on Inspection for severity, you must add the same to the
EGO_CHANGE_PRIORITIES lookup type.

• When the problem report is created from the inspection and the severity is "ORA_CRITICAL", you must add
the value ‘CRITICAL’ to the EGO_CHANGE_PRIORITIES lookup type, for the problem report to show the correct
priority.

• The profile option value is by default set to No.

The following nonconformance problem report types are supported:

• Nonconformance - Inventory

• Nonconformance - Resource

• Nonconformance - Receiving

• Nonconformance - Work in Process

• Nonconformance - Assets

You can also create these problem report types directly from the Quality Management work area outside the inspection
workflow and configure the attributes Source, Supplier, Customer, and Manufacturer for visibility on the predefined
types.

Points to Consider

• The problem report creation from the inspection would require the problem report number to be configured as
autosequence generated.
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• The severity in a quality issue is mapped to the priority in a problem report. If there are any configured options
for severity, remember to add the same as an option in priority too.

Related Topics
• Autocreate Problem Reports When Inspections Fail

Import Problem Reports and Corrective Actions  
As part of data migration, you can use the File-Based Data Import (FBDI) to import problem reports and corrective
actions in the Completed status.

Use the Change Order Import Template to import the completed problem reports and corrective actions for different
item revisions.

Download the latest ChangeOrderImportTemplate.xlsm spreadsheet from the File-Based Data Import (FBDI) for SCM. In
Change Orders, click ChangeOrderImportTemplate.xlsm.

Note:  For problem reports and corrective actions FBDI import you don’t need to specify the New Item Revision in the
ChangeOrderImportTemplate.xlsm.

The steps to import problem reports and corrective actions are the same as the steps to import change orders. For more
information, see Import Changes.

Configure Context Specific Attributes for Change Types  
You can configure context-specific attributes for change types at the header and line levels so that your users can view
and edit the attributes on the change. This feature is also available for supplier portal users.

Here are business objects which support this feature:

• Change orders

• Change requests

• Problem reports

• Corrective actions

Configure Context-Specific Attributes at Line Level
1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Product Management

◦ Functional Area: Change Orders

◦ Task: Manage Change Order and New Item Request Line Descriptive Flexfields

2. Select the task in the Change Orders functional area.
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3. Click Actions > Edit, to edit the flexfield named EGO_CHANGE_LINE.
4. Click Manage Contexts.
5. On the Manage Contexts page, click Create.
6. On the Create Context page:

◦ Context Code - this value must be same as the internal name of the change type for which you're
creating context-specific attributes.

◦ Enter the other details and click Save.

7. In Context Sensitive Segments, click Create.
8. On the Create Segment page, enter the details of the segment. Click Save and Close.
9. Return to the Manage Change Order and New Item Request Line Descriptive Flexfields page. Navigate to the

Context Sensitive Segments section and review the context sensitive segment you created in a previous step.
10. In Context Segment:

◦ Value Set: Select ORA_EGO_CHANGE_TYPES_VS.

◦ Default Type: Select Parameter.

Note:  If you've configured rules to propagate changes across organizations, ensure that you select
values in both Default Type and Value Set fields. This is required for propagation to be completed
successfully.

◦ Default Value: Select Product Context.

◦ Display Type: Select Hidden.

◦ Enter the other details of the segment and click Save.

11. Deploy flexfields using the Deploy Item Extensible Flexfields task (in the Setup and Maintenance work area for
the Product Management Offering).

Configure Context-Specific Attributes at Header Level
Prerequisite: Note down the internal name of the change type for which you want to create context-specific attributes
at the header level.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Product Management

◦ Functional Area: Change Orders

◦ Task: Manage Change Order and New Item Request Header Descriptive Flexfields

2. Click Manage Context.
3. In the Manage Context window, click Actions > Create.
4. In the Display Name and the Context Code fields, enter the internal name of the change type for which

you want to create descriptive flexfields at the header level. Note that the API name field gets populated
automatically.

5. Click Save.
6. To create attributes, in Context Sensitive Segments, click Create.
7. In the Create Segment page, enter the details of the header level descriptive attribute. Click Save and Close.

You must repeat this step for each attribute.
8. In the Manage Change Order and New Item Request Header Descriptive Flexfields page, click Deploy

Flexfields.
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Considerations for Adding Descriptive Flexfields
Here’s the total number of global and context descriptive flexfields that you can create for each context:

Datatype Character Limit Number of Global + Context Descriptive

Text 150 50

Text 4000 20

Number - 20

Extensible Number - 100

Date - 35

Time Stamp - 10

Here's an example:

You can create a total of 50 Text fields. Let’s say you've already created the following:

• 10 Global descriptive flexfields

• 10 Context descriptive flexfields

Then you’ll have 50 – (10+10), that is, 30 fields that you can still create.

Note:  The character limit is 4000 characters for descriptive flexfield attributes corresponding to table columns
ATTRIBUTE26 through ATTRIBUTE30 and ATTRIBUTE56 through ATTRIBUTE70.
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10  Manage Audit Policies

Manage Audit Policies  
You can use audit policies to configure specific objects and attributes and include them in the audit. The Manage Audit
Policies task enables you to select the attributes of the issue or action object that you want to audit.

Whenever you create, update, or delete an object or its attributes, navigate to Audit Reports to view the changes. The
Audit History includes only those object fields selected for audit.

You can access this task from the following in the Setup and Maintenance work area:

• Offering: Product Management

• Functional Area: Audit Trail

• Task: Manage Audit Policies

Here are the steps to configure which attributes appear in the audit report:

1. In the window that opens, click the Configure Business Object Attributes button.
2. From the Product list, select:

◦ Quality Issue and Action Management for quality issues and actions.

◦ Product Hub for item and change.

3. Select the issue or action object and click Create.
4. Select all the additional attributes that must be part of the audit from the Select and Add Audit Attributes

dialog.
5. Click OK.
6. Click Save and Close.

You can also enable the objects that you create or configure using Application Composer for audit. In the
Product list, these objects appear within Supply Chain Management Common Components.

Note:  The audit framework doesn't support long text (up to 4500 characters) and rich text attributes.

Objects You Can Enable for Audit  
The following table lists objects and attributes in the Quality Management work area that you can enable for auditing.

Object Attribute

Quality Issue • Quality Issue

• Quality Issue Attachment

• Quality Issue Affected Object
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Object Attribute

• Destination Quality Issue

• Source Quality Issue

Quality Action • Quality Action

• Quality Action Attachment

• Quality Action Affected Object

• Destination Quality Action

• Source Quality Action

Business Objects in Changes Node
The following table provides the business objects for the Changes parent node.

Node Name Node Description Parent Node

Changes Includes a collection of business objects that
maintain change order data.

Note:  To view trading partner reference
attributes in audit reports for change orders,
 problem reports, and corrective actions,
 enable the attributes Customer, Supplier,
 Source, and Manufacturer for audit.

Change Object Change object header level attributes Changes

Change Object Attachments Change object attachment attributes Change Object

Affected Objects Affected object attributes Change Object

Change Object Tasks Change object task attributes Change Object

Source Change Object Source change object attributes Change Object

Destination Change Object Destination change object attributes Change Object

Source Change Object Rule Source and Destination object type and status
attributes

Change Object

Destination Change Object Rule Destination and Source object type and status
attributes

Change Object

Change Object Extensible Flexfields Extensible flexfield attributes for change orders Change Object
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11  OTBI Reports in Quality Management

Overview of OTBI Reports in Quality Management  
Generate Oracle Transactional Business Intelligence (OTBI) reports from inspection results to quickly view, analyze, and
make informed decisions.

While generating a report, you may use one of the following as the report source:

• Data model

• Spreadsheet

• Subject area

For example, to analyze quality results, you can use the "Quality Inspection Results Real Time" subject area as source,
and generate a report in the required layout with selected fields in it.

Related Topics
• Overview of Ad Hoc and Inline Inspections

Navigate from OTBI Reports to Quality Issues and
Actions  
Oracle Transactional Business Intelligence (OTBI) reports provide a deep perception of situations in quality issues
and actions. Navigating from an OTBI report to the actual record in Quality Management helps you take quick and
appropriate action on specific objects.

Let's create a report with links that will take you directly to the object in the report. Firstly, begin by searching where you
can copy the basic URL format for an object's deep link.

1. Navigate to Tools > Deep Links list where you start creating your dynamic URL.
2. Search for Quality and from the search results click Quality Action.
3. From the search results, you can find the action and the object type to use. Copy the URL and paste it into a text

file
4. Add the remaining details to the URL like the object key. Example: &objKey=issueId=<ISSUE_ID>

In the Overview page of the Quality Management work area, expand the Reports and Analytics side panel and click the
Browse Catalog icon to navigate to OTBI.

1. From the Catalog pane, click New and select the Analysis option.
2. From the panel that opens, select a Subject Area. For example: Enterprise Quality Issues Real Time.
3. Double-click the column names in the Subject Areas pane to add them to the analysis.
4. You must add the Object Name and ID. Other columns of data are optional. For example: If you're creating

navigation to Quality Management, Quality Issue Name, Issue ID must be available in the query found in Quality
Issues Details.

5. Set Issues ID to a Number Format.
a. In the Issue ID column (Selected Columns), click the wheel icon and select Column Properties.
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b. In the Column Properties dialog, from the Data Format tab, select the Override Default Data Format
check box.

c. Change the Treat Numbers As field to Number and set the Decimal Places to Zero.
d. Click OK.

6. Set Name to a URL, so that it opens the selected object in another tab.

a. In the Issue Name column ( Selected Columns), click the wheel icon and select Column Properties.
b. Click Interaction. Select Actions Links from the Primary Interaction list to add a new link format.
c. Click the plus icon to add a new action link. In the New Action Link dialog, click the Create New Action

icon and select Navigate to a Web Page.
d. Enter the URL of the work area that you want to navigate from OTBI.

For quality actions, use https://<hostname>/fscmUI/faces/deeplink?
objType=ACTIONS&action=EDIT&objKey=actionId=<ACTION_ID>

For quality issues, use https://<hostname>/fscmUI/faces/deeplink?
objType=ISSUES&action=EDIT&objKey=issueId=<ISSUE_ID>

7. Let's Define Parameters.

a. Click Define Parameters.
b. In the "objKey" row, click the list icon in the Value column and select Column Value. Now click the Column

Value list icon and select "Enterprise Quality Issues Real Time"."Quality Issues Details"."Issue ID" from the
list.

c. In the URL field, add issueId (or actionId) into the URL so that the final part shows as:
&objKey=issueId=@{3}

d. Check the Fixed and Hidden check boxes for each row.
e. Click Options and the Action Options window opens.
f. Check the 'Open in New Window' check box and click OK. You return to the Create New Action window.

8. Click OK. You return to the New Action Link window.
9. Click OK. You return to the Column Properties window.

10. Check the 'Don't display in a pop-up if only one action link is available at runtime' check box.
11. Click OK.
12. Save the report. Click Results to display the report values.
13. Click any object name link and the quality issue or action opens in the Edit page in Quality Management.

Note:  The link to the quality issue or action is enabled only if the deep link is configured in reports.

For more details, refer the Subject Areas for Transactional Business Intelligence in SCM guide.

Related Topics
• Watch video: Create an OTBI Report with Direct Links for Quality Management

Add Configured Attributes to Reports  
You can configure attributes for quality issues and actions using Application Composer and use these attributes in OTBI
reports.
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The following are the supported field types for quality objects: Text, Number, Date, Long Text, Check box, Percentage,
Datetime, Record Type, Choice List (Fixed), Choice List (Dynamic), and Formula.

To view configured attributes in reports, you must first add them into the quality analyses. To create a new analysis,
navigate to Tools > Reports and Analytics > Browse Catalog > New > Analysis.

• For Quality Action reports: Select Enterprise Quality Actions Real Time subject area > Quality Actions Custom
Attributes

• For Quality Issue reports: Select Enterprise Quality Issues Real Time subject area > Quality Issues Custom
Attributes

You can add configured long text attributes to your analysis to include descriptions, closure reasons, resolution notes,
and so on, in your quality reports. These attributes are Character Large Object (CLOB) fields.

Related Topics
• Long Text Fields
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